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Safety

Read this section before installing and operating the GX-281 Liquid Handler.

The GX-281 Liquid Handler is intended to be used in a laboratory environment by trained technical
personnel.

For safe and correct use of this instrument, itis recommended that both operating and service personnel
follow the instructions contained in this guide when installing, cleaning, and maintaining the
instrument.

The following safety precautions must be observed during all phases of operation, service, and repair of
the instrument. Failure to comply with these precautions or with specific warnings elsewhere in this
user’s guide violates safety standards of design, manufacture, and intended use of the instrument.
Gilson assumes no liability for the customer’s failure to comply with these requirements.

The liquid handler has been certified to UL, CSA, and CE Safety standards.

Gilson GX-281 Liquid Handler User’s Guide Safety-1



Safety

The following electronic and hazard symbols may appear on the instrument:

Symbol Explanation

Alternating current
~ Courant alternatif
Wechselstrom

Direct current
- = Courant continu

Gleichstrom

Protective conductor terminal

@ Borne de terre de protection

Schutzleiteranschluss

Electrical power ON
Sous tension
Netzschalter ein

Electrical power OFF
Hors tension
Netzschalter aus

Caution
Attention
Vorsicht

o)
Caution, risk of electric shock
A Attention, risque de choc électrique
Vorsicht, Elektroschockgefahr
=

Caution, hot surface
Attention, surface chaude
Vorsicht, heif3e Oberflache

Fuse
Fusible

Sicherung
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Safety

The following safety notices may appear in this document:

WARNING indicates a potentially hazardous situation which,

/AWARNING if not avoided, may result in serious injury

CAUTION indicates a potentially hazardous situation which,

ACAUTION if not avoided, may result in minor or moderate injury

NOTICE indicates a potentially hazardous situation which,
NOTICE if not avoided, may result in equipment damage

Voltage

Access to the rear panel is necessary. The instrument must be detached from all
voltage sources before service, repair, or exchange of parts.

For normal operation, the instrument is to be grounded through the AC line cord
provided. Failure to do so can result in a potential shock hazard that could result
in serious personal injury.

Use only fuses with the rated current and of the specified type (fast acting,
normal blow, time delay) as listed on the rear panel of the instrument.

The instrument must only be operated with the voltage specified on the rear
panel label of the instrument using a grounded AC line cord.

Probes

While operating the liquid handler, keep hands clear of probe to avoid risk of
personal injury by piercing.

Because the probe installed on the Z-arm may contain a dangerous substance,
do not interfere in the work area of the instrument until the liquid handler has
completed its procedures.
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Safety

Solvents

Observe safe laboratory practices when handling solvents. If dangerous liquids
are used, adequate protection such as proper ventilation, safety glasses, etc.,
should be used.

Refer to the Material Safety Data Sheets for the solvents before use.

Replacement Parts

Be sure to use only replacement parts mentioned in Chapter 4, Maintenance
and Appendix A, Replacement Parts and Accessories. Do not repair or change
parts which are not listed in this user’s guide. If it is necessary to change parts not
listed, please contact your Gilson-authorized representative.

Safety-4 Gilson GX-281 Liquid Handler User’s Guide



Introduction

This chapter provides information on the following topics:
- Description

« Unpacking

« Customer Service

« Technical Specifications

GX-281 Liquid Handler
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Description

Introduction
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Description

The GX-281 Liquid Handler is an X/Y/Z instrument that can automate liquid
handling procedures. The locator plate can be configured with several different
accessories and racks. The GX-281 Liquid Handler can be configured with a
solvent system, two different types of injection modules, a fraction collection
valve, and a rinse pump.

The GX Solvent System, included with the GX-281 Liquid Handler, is a
bi-directional pump that can switch from aspirate to dispense mode. The

GX Analytical Solvent System can handle flow rates up to 5 mL/min. The GX Prep
Solvent System can handle flow rates up to 50 mL/min. The solvent selection
valve on the GX Solvent System can accommodate up to five different reservoir
solvents.

Optional Accessories

The GX Z Injection Module is mounted on the Z-arm of the liquid handler. The
probe is plumbed directly to the GX Z Injection Module, eliminating the need for
an injection port.

The GX Direct Injection Module is mounted on the locator plate of the GX-281
Liquid Handler. The GX Direct Injection Module has an option of four different
valves (for 1/8" OD sample loops or 1/16" OD sample loops). The valves available
for the GX Direct Injection Module feature a vertical direct connection for the
injection port. Up to two GX Direct Injection Modules can be placed on the
locator plate of the GX-281 Liquid Handler.

The Fraction Collection Valve is a three-way valve mounted low on the Z-arm.
This design allows for reduced dead volume and collection of larger volumes.

Gilson GX-281 Liquid Handler User’s Guide



Introduction

Unpacking

The GX-281 Liquid Handler is delivered with all major components already
assembled except for auxiliary parts such as the Z-arm, probe, racks, tubing, etc.
Keep the original container and packing assembly in case the liquid handler must
be returned to the factory.

To unpack the GX-281 Liquid Handler:

1 Cut the metal strapping holding the cardboard boxes together.

2 Lift the top box off and away from the liquid handler.

3 Remove the accessory boxes from the locator plate of the liquid handler.

4

Lift the unit off its base platform and place it on a lab bench or cart.

/ACAUTION | |tis recommended that at least two people lift the liquid

handler off the base of the packing container as it weighs
over 68 kg (150 Ibs).

['Teiila3 Do not attempt to lift the instrument from the Y-arm (the
horizontal arm). Always lift the instrument from its base.

To lift the liquid handler:
a) Grip the liquid handler under the base plate.

b) Lift the unit up and out of the foam packing material.

Gilson GX-281 Liquid Handler User’s Guide
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Unpacking

Introduction 1
Standard Equipment
After the liquid handler and accessories have been unpacked, you should have
these items:
+  One of the following liquid handlers:
Part Number Description
261030 GX-281 Liquid Handler with GX Prep Solvent System
GX-281 Liquid Handler with GX Prep Solvent System and
261031
bar code reader
261032 GX-281 Liquid Handler with GX Analytical Solvent System
GX-281 Liquid Handler with GX Analytical Solvent System
261033
and bar code reader
«  Z-arm
« Z-arm cable assembly
«  GXAnalytical Solvent System or GX Prep Solvent System which include valve
to pump tubing, solvent inlet tubing, waste tubing and fittings, dowel pins,
and power cable
GX-281 shield kit
«  Accessory package which includes Z height adjustment tools (125, 175, and
210 mm), lower probe holder cover, GSIOC cable, RS-232 cable, two
3/16" shoulder bolts, 5/32" tee handled Allen wrench, 3/32" Allen wrench,
socket drive, waste tubing and fittings, cable clips and attachment screws,
spline wrench for headless nuts, fuses, and fuse drawers
+ power cords
«  GX-281 Offset Utility Kit
Documentation
The following documents are included with the GX-281 Liquid Handler:
GX-281 Liquid Handler Documentation CD
+ Installation Qualification/Operational Qualification Procedures
Unpacking the GX-281 Liquid Handler
«  Declaration of Conformity
1-4 Gilson GX-281 Liquid Handler User’s Guide



Introduction

Accessories

Based upon your configuration, you also ordered and received additional
accessories, such as the probe, transfer tubing, sample loops, racks, etc. If
necessary, refer to Appendix A, Replacement Parts and Accessories for
part numbers.

Guide Foot Assembly

Part number Description

26036197 Guide foot assembly for 1.3 mm probes
26036198 Guide foot assembly for 1.5 mm probes
26036199 Guide foot assembly for 1.8 mm probes
26036200 Guide foot assembly for 2.3 mm probes
26036201 Guide foot assembly for 2.7 mm probes

Optional Accessories
GX Direct Injection Module

Part number Description

261354 GX Direct Injection Module, 1/16" Prep

261355 GX Direct Injection Module, 1/8" Prep

261356 GX Direct Injection Module, 1/16" Analytical, Stainless Steel
261357 GX Direct Injection Module, 1/16" Analytical, PEEK
26035470 Plumbing Package, Direct Inject 1/16" and 1/8"

GX Z Injection Module

Part number Description

261353 GX Z Injection Module

26035370 Plumbing Package, Z Inject

GX Rinse Pump

Part number Description

261352 GX Rinse Pump

Gilson GX-281 Liquid Handler User’s Guide
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Unpacking

Introduction 1
Fraction Collection Valve
Part number Description
2604705 GX-Series Low Mount Fraction Collection Package

1-6 Gilson GX-281 Liquid Handler User’s Guide



Introduction

Customer Service

Gilson, Inc. and its worldwide network of authorized representatives provide
customers with the following types of assistance: sales, technical support,
applications, and instrument repair.

If you need assistance, please contact your Gilson-authorized representative.
Specific contact information can be found at www.gilson.com. To help us serve
you quickly and efficiently, please refer to Before Calling Us on page 5-9.

Gilson GX-281 Liquid Handler User’s Guide
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Technical Specifications

Introduction

Technical Specifications

Please be aware of the following before operating the liquid handler.

NOTICE Changes or modifications to the liquid handler not expressly
approved by Gilson could void the warranty.

This instrument complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) this instrument may not cause harmful
interference, and (2) this instrument must accept any interference received,
including interference that may cause undesired operation.

Shielded cables must be used with the liquid handler to ensure compliance with
the FCC Class A limits.

Gilson GX-281 Liquid Handler User’s Guide



Introduction 1

GX-281 Liquid Handler

Technical Specification Definition

Arm Speed 0.01 to 600.00 mm/sec in X dimension
0.01 to 600.00 mm/sec in Y dimension
0.01 to 125.00 mm/sec in Z dimension

Contact Control Four inputs (contact closure, TTL), four relay outputs, four
switched +24V DC 1A outputs, one safety input, and one
analog input

suonedyads |esiuyday

Note: For your safety, do not switch voltages higher than
30V even though the output contacts are rated for high
voltage.

Data Acquisition An input channel for analog-to-digital conversion
Input impedance: More than 100K ohms
Input voltage range: -1.0V to +1.0V
Input resolution: 10uV

Dimensions (W x D x H) 88.9x76.2x96.5cm (35x30x38in)

Display Two lines of 40 alphanumeric characters; vacuum
fluorescent display

Environmental Conditions Indoor use
Altitude: up to 2000 m
Temperature range: 5°-40°C
Air pressure: 75-105 kPa

Humidity: Maximum relative humidity 80% for temperatures
up to 31°C, decreasing linearly to 50% relative humidity at

40°C
Front Panel ON/OFF and sTOP soft keys and LED indicator light for power
Fuse 5x20 mm “T” type 5.0A

One for 100-120V; two for 220-240V

continued (1 of 2)
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Technical Specifications

Introduction 1

GX-281 Liquid Handler (Continued)

Technical Specification Definition

Horizontal Motion Strength  X:1.4kg (3 Ibs)
Y: 0.7 kg (1.5 Ibs)
Z:5.4kg (12 Ibs)

Locator Plate Capacity Up to six Code 200-series racks
Qty | Capacity Gilson rack (qty)
576 13 x 100 mm tubes Code 200 (6)
450 16 x 100 mm tubes Code 207 (6)
420 18 x 150 mm tubes Code 208 (6)
20 mL scintillation vials Code 204 (6)
b 40 mL scintillation vials Code 219 (6)

For a full list of available racks go to www.gilson.com.

Power Requirements Frequency: 50 to 60 Hz
Voltage: 100-240V (Universal Input)
Current rating: 5.0A for 100-120V or 2.5A for 220-240V

Power consumption: 500W maximum

Probe Positioning Accuracy: +/- 0.05 mm in X/Y/Z dimensions
Performance Repeatability: +/- 0.025 mm in X/Y/Z dimensions
Probe Rinse Probe rinsing occurs through a dedicated rinse station
Safety Approvals/ Certified to UL, CSA, CE, and C-Tick Safety and EMC
EMC compliance standards.
Sampler Type X/Y/Z with stationary rack design
Software Control Computer control via RS-232 or GSIOC and TRILUTION®

software
Vertical Punch Strength 4.5 kg (10.0 lbs)
Weight 68.0 kg (150 Ibs)

continued (2 of 2)
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Introduction

GX Solvent System

Technical Specification

Definition

Back Pressure

50 psi

Dimensions (W x D x H)

10.8x14.8x18.2cm (4.25x5.83 x7.151in)

Flow Rate

Analytical
500 nL/min up to 5 mL/min

Preparative
1 uL/min up to 50 mL/min

Liquid Contact Materials

Valcon H, Nitronic 60 (N60), PTFE

Power Requirements

Voltage: 24V DC
Current rating: 1.5A

Pump Internal Volume

Analytical
100 uL £ 2 pL

Preparative
625uL £ 12 L

Selection Valve Switching
Speed

180 msec

Volumetric Accuracy

See Appendix B, Specifications Methods for details about
the configuration and test procedure that Gilson used to

determine the limits below.
Accuracy: £2% for (100 puL-25 mL) water

Weight

2.2kg (4.9 Ibs)

Gilson GX-281 Liquid Handler User’s Guide
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Technical Specifications

Introduction

GX Direct Injection Module

Technical Specification

Definition

Available Valves

Analytical

Stainless steel direct injection valve
(2-position, 6-port) 0.016" ID ports, 1/16" OD
PEEK direct injection valve

(2-position, 6-port) 0.016" ID ports, 1/16" OD

Preparative

Stainless steel direct injection valve
(2-position, 6-port) 0.060" ID ports, 1/8" OD
Stainless steel direct injection valve
(2-position, 6-port) 0.030" ID ports, 1/16" OD

Available Sample Loops

Analytical

For GX Direct Injection Module (1/16"): 2 uL, 5 pL, 10 pL,
20 pL, 50 pL, 100 uL, 250 uL, 500 uL, 1 mL, and 2 mL

Preparative
For GX Direct Injection Module (1/8"): 5 mL, 10 mL, 20 mL,
and 25 mL

For GX Direct Injection Module (1/16"): 250 pL, 500 pL, 1 mL,
2mL,and 5 mL

Dimensions (W x D x H)

12.1x8.9x10.1 cm (4.75 x 3.50 x 3.98 in)

Front Panel

LED indicator for LOAD and INJECT positions

Injection Carryover

<0.005%

Injection Reproducibility

See Appendix B, Specifications Methods for details about
the configuration and test procedure that Gilson used to
determine the limits below.

<1.0% CV (total loop)

<3.5% CV (partial loop)

Liquid Contact Materials

Valcon H, Nitronic 60 (N60), PTFE

continued (1 of 2)
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Introduction

GX Direct Injection Module (Continued)

Technical Specification

Definition

Power Requirements

Voltage: 24V DC
Current rating: 1.0A

Valve Switching Speed

Analytical
200 msec for GX Direct Injection Module (1/16")

Preparative
200 msec for GX Direct Injection Module (1/16")
300 msec for GX Direct Injection Module (1/8")

Weight

1.2 kg (2.63 lbs)

continued (2 of 2)

GX Z Injection Module

Technical Specification

Definition

Available Valves

Continuous flow Valco valve for 1/16" OD sample loops

Available Sample Loops

250 uL, 500 uL, 1 mL, 2 mL, and 5 mL

Dimensions (W x D x H)

7.2x14.7%x9.2cm (2.82x5.80x 3.63in)

Injection Reproducibility

See Appendix B, Specifications Methods for details about
the configuration and test procedure that Gilson used to
determine the limits below.

<2.0% CV (partial loop)

Liquid Contact Materials

Valcon H, Nitronic 60 (N60), PTFE

Power Requirements

Voltage: 24V DC
Current rating: 1.0A

Valve Switching Speed

180 msec

Weight

1.1 kg (2.53 lbs)

Gilson GX-281 Liquid Handler User’s Guide
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Technical Specifications

Introduction 1

GX Rinse Pump

Technical Specification Definition

Contact Control One input (contact closure) and one switched +24V DC 1A
output

Dimensions (W x D x H) 12.1x89x18.3cm (476 x3.5x7.2in)

Power Requirements Voltage: 24V DC

Current rating: 1.0A

Rinse Speed High speed: 200 rpm
Low speed: 120 rpm

Weight 1.0 kg (2.28 Ibs)

Fraction Collection Valve

Technical Specification Definition

3-Way Valve Three-port, PTFE, 114 pL internal volume, 10 yL dead
volume, up to 200 mL/min

1-14 Gilson GX-281 Liquid Handler User’s Guide



Installation 2

The liquid handler and its components should be set up and installed in the following order. Complete
instructions for each step are included in this chapter.

1 Cable Clip Installation

Z-Arm Setup

Z-Arm Cable Assembly Setup and Installation
Z-Arm Installation

GX Z Injection Module Installation (Optional)
Locator Plate Setup

Rack Installation

0 N o0 O unn b~ W N

RS-232, GSIOC, and Input/Output Connections
Plumbing Connections

10 Final Rear Panel Connections

11 Shield Installation

12 Final Z-Arm Height Adjustment

13 Unit ID Selection—GX-281 Liquid Handler

14 GX-281 Offset Utility

Gilson GX-281 Liquid Handler User’s Guide 2-1



Installation

GX Z Injection
Module

fraction collection valve

Y-arm
GX Rinse Pump

rinse station

"'
: —r

R S

[

GX Direct Injection
Module

GX Solvent
System

locator plate

s e wla A &l& «

,Im  —— front panel \
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Installation

Cable Clip Installation

The cable clips will be used to route the transfer tubing and the Z-arm cable.

1 Locate the five cable clips and Phillips screws that were included in the
accessory package.

2 Attach the clips to the back of the liquid handler using a Phillips screwdriver.
Refer to the diagram for location and orientation.

o o o /E]

install cable clips here \
: 5‘/ : \ 4

uonejjeisuj dij) sjqed

]

—

back of GX-281 Liquid Handler
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Z-Arm Setup

Installation 2

Z-Arm Setup

All of the components of the Z-arm must be installed before the Z-arm is
attached to the instrument. Do not install the Z-arm until instructed to do
so.

The Z-arm and its components should be assembled and installed in the
following order:

1 Guide Foot Assembly

Lower Probe Holder Installation

Guide Foot Installation

Fraction Collection Valve Installation (Optional)

Z-Arm Cable Assembly Setup and Installation

Z-Arm Installation

Z-Arm Cable Connection

0 N o v b~ w N

Z Travel Height Adjustment

Probe Installation

10 LLD (Liquid Level Detection) Cable Installation
11 GX Z Injection Module Installation (Optional)
12 Final Z-Arm Height Adjustment

2-4 Gilson GX-281 Liquid Handler User’s Guide



Installation

Guide Foot Assembly

The guide foot assembly (ordered separately) includes the following parts: the
guide foot, the probe guide insert and cover, the lower probe holder and cover,

and six screws.
cover for
lower probe holder
lower probe holder
/
cover for \f‘
probe guide insert -
probe guide insert

Phillips screws
\
1
There are different sizes of guide foot assemblies available depending on the

outer diameter of the probe being used. Each probe guide is marked with a
number of spots. Refer to the table for part numbers.

Probe | Guide Foot Assembly | Probe Guide Insert | Lower Probe Holder
oD Part Number Part Number Part Number
1.3 mm 26036197 2603614215 2603614111
1.5mm 26036198 2603614216 2603614112
1.8 mm 26036199 2603614217 2603614113
2.3 mm 26036200 2603614218
2603614114
2.7 mm 26036201 2603614219

Gilson GX-281 Liquid Handler User’s Guide
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Installation
2 Lower Probe Holder Installation
frer)
[
VE' The lower probe holder is installed on the front of the Z-arm, below the isolation
E probe holder.
N
Before beginning this procedure locate the following:
« 1/4" socket (part number 4351025) included in the GX-281 accessory
package
+ lower probe holder cover (part number 2603614102) included in the
guide foot assembly
+ lower probe holder, included in the guide foot assembly
To install the lower probe holder:
// cover
y 1 Lay the Z-arm on its back on a flat surface.
2 Orient the cover so that the stop on the inside is closer to the bottom and
stop then slide the cover over the lower probe holder.
LV Note: The lower probe holder should be flush with the cover; if it extends
past the end of the cover, the cover is not oriented correctly. Refer to the
L diagram for the correct orientation.
3 Place the smaller end of the 1/4" socket over the bottom of the lower probe
holder. Then place this assembly at the bottom of the probe holder sleeve.
4 Rotate the 1/4" socket clockwise to tighten. Then remove the 1/4" socket.

slide the cover over the
lower probe holder

2-6

isolation probe holder

probe holder sleeve

cover

lower probe holder

-
f

place the 1/4" socket over
the bottom of the lower
probe holder
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Installation 2

Guide Foot Installation

To install the guide foot on the Z-arm:

1
2

Lay the Z-arm on its back on a flat surface.

Place the guide foot below the Z-arm flat edge
and align the four holes on the guide /

foot with the holes on the bottom of the Oo © © o O > cutout
Z-arm.

Note: Orient the guide foot with the flat | O o ©
edge at the back and the cutout on the o)
top. The cutout will fit in the indent on

the Z-arm. top view of guide foot

Place four of the Phillips screws through
the bottom of the guide foot into the Z-arm and tighten.

To install the probe guide insert on the guide foot:

1
2

Place the probe guide insert on top of the guide foot.

Place the cover over the probe guide insert and align the holes on the cover
with the holes on the guide foot.

Place the remaining two Phillips screws through the bottom of the guide foot
into the cover and tighten.

cover

lower probe holder

cover

probe guide insert

1

Gilson GX-281 Liquid Handler User’s Guide 2-7
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Z-Arm Setup

Installation

Fraction Collection Valve Installation (Optional)

The fraction collection valve is included tube and wire

in the GX-Series Low Mount Fraction routing strip

Collection Package (ordered separately,

part number 2604705).

To install the fraction collection valve on

the guide foot:

1  Place the valve on top of the guide
foot as shown in the photo. Align the
two holes on the bottom of the valve
with the holes on the guide foot.
Attach the valve to the guide foot
using the two Phillips screws
included with the valve. 2 2

2 Connect the green cable from the fraction collection valve installed on
valve to the FC VALVE port on the the guide foot
side of the Z-arm.

Tube and Wire Routing Strip Installation

The tube and wire routing strip (part number 26036143) is included with the

fraction collection valve.

To install the tube and wire routing strip:

1 Locate the two raised rails on the right side of the Z-arm.

2 Attach theright side of the tube and wire routing strip to the right side of the
rail on the Z-arm.

3 Snap the left side of the tube and wire routing strip over the left side of the
rail on the Z-arm.

2-8 Gilson GX-281 Liquid Handler User’s Guide



Installation

Z-Arm Cable Assembly Setup and Installation

The Z-arm cable assembly is included with the GX-281 Liquid Handler.

Z-Arm Cable Assembly Setup

Some of the tubing will be placed in the Z-arm cable assembly before being
connected to the instrument. To prepare for this:

1 Laythe Z-arm cable assembly on a flat surface with the “zipper” facing up.

2 Remove the “zipper” by pulling up and out on the bottom end. Leave the
Z-arm cable in the assembly. Then set the “zipper” off to the side.

3 Place the following tubing in the Z-arm cable assembly. For more detailed
information, including part numbers, refer to Plumbing Connections on
page 2-29. (Do not connect any of the tubing until instructed to do so.)

a) transfer tubing assembly

« The end of the transfer tubing with the headless nut attached
and the shorter length of Z-arm cable should exit the same end
of the assembly.

« The coiled end of the transfer tubing and the longer length of
Z-arm cable should exit the same end of the assembly.

b) PEEK tubing (for FC valve only)

c) Teflon waste tubing (for FC valve only)

d) PEEK tubing (for GX Z Injection Module only)
e) PEEK tubing (for GX Z Injection Module only)

Z-arm cable assembly __ &
grommet ;f'

Z-arm cable

)
)

i :
®
GX Solvent System and GX Solvent System, FC valve, and
FC valve plumbing GX Z Injection Module plumbing

4 After all of the tubing is in place in the Z-arm cable assembly replace the
“Zipper”.

Gilson GX-281 Liquid Handler User’s Guide
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Z-Arm Cable Assembly Setup and Installation

Installation 2

Z-Arm Cable Assembly Installation

To install the Z-arm cable assembly on the Z-arm:

1 Orient the Z-arm cable assembly and tubing so that the short end of the
Z-arm cable is closest to the Z-arm.

2 Route all of the tubing at that end of the assembly (except the transfer
tubing) through the grommet on the right side of the Z-arm.

3 Route the tubing for the fraction collector down through the tube and wire
routing strip on the side of the Z-arm.

4 Connect the Z-arm cable to the port on the top of the Z-arm.

2-10 Gilson GX-281 Liquid Handler User’s Guide



Installation

Z-Arm Installation

Follow these steps to install the Z-arm: Y-arm Z-arm

1

Using the supplied 5/32" T-handled
Allen wrench, loosen the mounting
screw on the Z-arm mounting
bracket located on the Y-arm. Turn
counterclockwise to loosen.

Partially pull out the bracket. Do not
remove completely.

Place the Z-arm into the mounting
bracket. Insert one side of the Z-arm
into place at a time (back to front).

Tighten the screw on the mounting

bracket until the Z-arm is secure. mounting
screw

The Z-arm will be set to its proper height
as the final step of the installation. This adjustment is described in Final Z-Arm

Height Adjustment on page 2-43.

Gilson GX-281 Liquid Handler User’s Guide
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Z-Arm Installation

Installation

Z-Arm Cable Connection

To connect the Z-arm cable to the liquid handler:
1 Place the end of the Z-arm cable through the bracket on the back of the
liquid handler.

2 Route the Z-arm cable and the transfer tubing through the clips on the back
of the liquid handler. Refer to the diagram for the location of these clips.

3 Connect the Z-arm cable to the Z ARM port on the rear panel of the liquid
handler.

bracket

transfer
tubing

Z-arm cable\
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Installation

Z Travel Height Adjustment

Follow these steps to adjust the Z travel height:

1
2

Push the isolation probe holder down as far as it will go.

Locate the 3/16" bolt (part number 4014194160) that was included with the
Z-arm. (There are extra bolts included in the accessory package that came
with the liquid handler.)

|: mm 3/16" bolt

Place the bolt on the supplied 3/32" Allen wrench and insert into the proper
hole on the Z-arm. Turn clockwise to tighten.

« S1for 125 mm probes
« S2for 175 mm probes

« No boltinstalled for 210 mm probes

Note: Store the bolt in the right side bracket hole on the back of the liquid
handler for future use.

Probe Installation

There are different probes available for use on the GX-281 Liquid Handler.
Depending upon the application, purchase the appropriate probe and guide
foot assembly.

To install the probe on the Z-arm, insert the probe into the top of the isolation
probe holder and pull it through the holder until the tip of the probe is in the
probe guide insert.

Gilson GX-281 Liquid Handler User’s Guide
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probe
holder
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Z-Arm Installation

Installation

2-14

LLD (Liquid Level Detection) Cable Installation

The LLD cable assembly (part number
25064040) is included with the Z-arm.

To install the LLD cable assembly:

1 Tighten the hex nut on the right
side of the isolation probe holder.

2 Place the metal slotend of the cable
over the metal tab on the isolation
probe holder.

3 Plug the other end of the cable into

the LLD port on the right side of the .

Z-arm. Align the red line on the
cable with the slot on the port.

LLD
cable

isolator probe LLD port
holder

Gilson GX-281 Liquid Handler User’s Guide



Installation 2

GX Z Injection Module Installation (Optional)

To install the GX Z Injection Module on the Z-arm:

1 Using the supplied 5/32" T-handled
Allen wrench, loosen the mounting
screw on the mounting bracket
located on the GX Z Injection Module.
Turn counterclockwise to loosen.

Z INJECTION
VALVE port

2 Partially pull out the bracket. Do not
remove completely.

3 Mount the GX Z Injection Module on
the top left side of the Z-arm. Mount
one side of the injection module at a
time (back to front). The valve should
face the front and the mounting

bracket should face the right. mounting mounting
screw bracket

4 Tighten the screw on the mounting
bracket until the GX Z Injection Module is secure on the Z-arm.

GX Z Injection Module Rear Panel

To make connections between the GX Z Injection Module and the liquid handler:

1 Ensure that the power is turned off to the liquid FROM Z ARM
handler.

2 Plug one end of the cable supplied with the
GX Z Injection Module to the FROM Z ARM port on
the rear panel of the injection module. Align the
red dot on the cable with the red dot on the port. ponson®

Z INJECTION MODULE

3 Connect the other end of the cable to the port won CE
labeled Z INJECTION VALVE on the top right side of
the Z-arm, aligning the red dots on the cable and
the port.

GX Z Injection Module
rear panel

Gilson GX-281 Liquid Handler User’s Guide 2-15
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Locator Plate Setup

Installation 2

Locator Plate Setup

This section takes you through the installation and rear panel connections for
each accessory on the locator plate of the liquid handler.

To install accessories on the locator plate of the liquid handler refer to the
following diagram and instructions.

GX Rinse
GX Solvent System left Pump right
GX Direct GX Direct
Injection Module Injection Module
left right
support supp/ort
E o : o O ] = yessssadesssssas H
{ unitID O : :
fo ‘o o gresmrepeneeas . RIFEEEE R ‘
L : H HE [ H
. 1 Messsssssssssas 4o .
founitiD 3 o {°unitID4°;
N j N j

locator plate of the GX-281 Liquid Handler
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Installation

Rear Panel Connections

Refer to the following diagrams when making rear panel connections.

GX-281 Liquid Handler rear panel—partial
1 Gilson Serial Input/Output Channel (GSIOC) port

RS-232 port

Switched 24V DC power

Input/Output (I/O) ports/safety/analog
GSIOC accessories

Expansion GSIOC (not used)

Z-arm

GSIOC 2 (not used)

0 N o0 v b~ w N

Alignment kit laser port
10 Power receptacle
11 Power switch

12 Fuse drawer

Gilson GX-281 Liquid Handler User’s Guide
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Locator Plate Setup

Installation

2-18

GX Solvent System Installation

The GX Solvent System is installed next to the left support on the liquid handler
(as shown in the photo).

To install the solvent system on the locator plate:

1

Locate the two pins (part number 4533250050) shipped with the solvent
system and place them in the two holes on the back left side of the locator
plate. Refer to the diagram on page 2-16 for the location of these holes.

Align the pins with the holes on the solvent system. Then push the solvent
system into place.

GX Solvent System Rear Panel

To make connections between the solvent system and the liquid handler:

1

Ensure that the power is turned off to the liquid handler.

Note: Any time the solvent system will be disconnected from the liquid
handler ensure that the power is turned off to the liquid handler.

Connect theright-angled end of the power cable (part number 26035455) to
the FROM GSIOC ACCY port on the solvent system.

3 Connect the other end of the power cable to one of the GSIOC ACCESSORIES
ports on the rear panel of the GX-281 Liquid Handler.
UnitID

The unit ID on the solvent

system is set to 0. FROM GSIOC ACCY port._ |
unitID
power cable
GX Solvent
System
: 2

© ©

]

GX-281 (partial)

GX Solvent System connected to the liquid handler

Gilson GX-281 Liquid Handler User’s Guide



Installation

Rinse Station Installation

The rinse stations are installed on the locator plate. Refer to the diagram for the
location of the rinse stations.

o o o o o o oo
o o o o o o
o
(e]
(0]
09 olo oo olo oo olo 9%

Up to six rinse stations can be installed on the locator plate of the liquid handler.
There are two types of rinse stations available. Each of these is available in three
different heights.

Available rinse stations:

Part number Description

Rinse station, GX 125 mm

dnjag aje|d 103ed07]

26034552
(Rinse station for outside rinse of probe)
Ri i X17
26034551 |r15e Statl‘On, G 5 mm .
(Rinse station for outside rinse of probe)
Ri i X 21
26034553 |r15e statlfm, G 0 mm .
(Rinse station for outside rinse of probe)
Ri i X12 F
26034554 msg st?tlon, G ‘ 5 m'm‘ C ‘
(Drain/rinse station for inside rinse of probe)
Ri i X17 F
26034555 msg st?tlon, G ‘ 5 m'm‘ C ‘
(Drain/rinse station for inside rinse of probe)
Ri i X 21 F
26034556 inse station, G 0 mm FC

(Drain/rinse station for inside rinse of probe)

Gilson GX-281 Liquid Handler User’s Guide



Locator Plate Setup

Installation

5)

rinse station
main body

socket head
cap screw

rinse station
support

2-20

Before installing the rinse station determine what type
of rinse you will be performing. 1

With the Rinse Station for Outside Rinse of Probe you
can perform a static rinse or a flowing rinse using the
GX Rinse Pump.

Use the Drain/Rinse Station to perform an inside rinse.

set up for
staticrinse

For a static rinse place the plug in the bottom hole
and the drain in the top hole.

Foraflowingrinse place the pluginthe top hole and
the drain at the bottom

5

set up for
flowing rinse

rinse station for
outside rinse of probe

drain/rinse station for
inside rinse of probe

It is suggested to install the rinse station in the location closest to the injection
port on the GX Direct Injection Module (if installed).

To install the rinse station on the locator plate:

1

Locate the following items included with the rinse station:
»  rinse station support

+ socket head cap screw

Note: The rinse station also includes a flat-head screw and hex nut that will
not be used for this installation.

Use the socket head cap screw provided to fasten the rinse station support to
the base. Do not over tighten.

Place the main body of the rinse station on the support so that after it is in
place you can give it a 1/4 clockwise turn to secure the rinse station tightly.
For example, if you want the fittings on the rinse station to face the back,
initially place it so that the fittings are facing the left support of the liquid
handler.

Gilson GX-281 Liquid Handler User’s Guide



Installation

GX Rinse Pump Installation (Optional)

The GX Rinse Pump is installed on the right side
of the liquid handler between the GX Direct

Injection Modules (if installed).

To install the GX Rinse Pump on the locator plate:

1 Align the holes on the base of the GX Rinse
Pump with the holes on the locator plate of
the liquid handler. Refer to the diagram on
page 2-16 for the location of these holes.

2 Put the thumbscrews in place and tighten.

GX Rinse Pump Rear Panel

GX Rinse Pump on the locator
plate of the liquid handler

To make connections between the GX Rinse

Pump and the liquid handler:

1 Locate the GX Rinse Pump cable connector (part number 26035255). This
assembly contains three pre-wired terminal block connectors.

2 Connect the four pin terminal block connector to the rear panel of the

GX Rinse Pump.

3 Connect the eight pin terminal block connector to the +24V DC power
outputs on the rear panel of the GX-281 Liquid Handler. The wires should be
on the left side of the block when connected.

4  Connectthe ten pin terminal block connector to the output ports on the rear
panel of the GX-281 Liquid Handler. The wires should be on the left side of
the output block when connected.

input/output —————

ports

GX Rinse Pump
(partial)

© 6 O

; GX-281 (partial)

GX Rinse Pump connected to the liquid handler

Gilson GX-281 Liquid Handler User’s Guide 2-21
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Locator Plate Setup

Installation

for GX-281
use these holes

/

\

injection module

front

(top view)

/holes\

2603541 spi ns

/

GX-281 riser block

2-22

(top view)

GX Direct Injection Module Installation (Optional)

Up to two injection modules can be installed
on the locator plate of the liquid handler. One
is installed next to the right support of the
liquid handler and the other is installed on the
left side of the GX Rinse Pump (if installed).

Injection Module

To install the GX Direct Injection Modules on
the locator plate of the liquid handler:

Locate the pins(part number4533125037)
shipped with the injection module and

GX Direct Injection Module
on the locator plate
place them in the holes on the locator of the liquid handler

plate of the liquid handler. Refer to the
diagram on page 2-16 for the location of these holes.

2 Align the pins with the holes on the bottom of the injection module. Then
push the injection module into place.

3 Place one of the provided screws through the front set of holes on each side
of the injection module and tighten using the supplied ball driver wrench.

Injection Module with Riser Block

Use the GX-281 Direct Inject Riser Block (part number 26035457, ordered
separately) when collecting fractions to tubes 150 mm and taller.

To install the riser block and the GX Direct Injection Module on the locator plate:

1 Locate the pins (part number 4533125037) shipped with the injection
module and place themin the holes on the locator plate of the liquid handler.
Refer to the diagram on page 2-16 for the location of these holes.

2 Align the pins on the locator plate with the holes on the bottom of the riser
block. Then push the riser block into place.

3 Align the pins on the top of the riser block with the holes on the bottom of
the injection module and then push the injection module into place.

4 Place the two screws (included with the riser) through the front set of holes
on the injection module and tighten using the supplied ball driver wrench.

Gilson GX-281 Liquid Handler User’s Guide



Installation

GX Direct Injection Module Rear Panel
To make connections between the GX Direct Injection Module and the liquid
handler:

1 Ensure that the power is turned off to the liquid handler.

Note: Any time the injection module will be disconnected from the liquid
handler ensure that the power is turned off to the liquid handler.

2 Connecttheright-angled end of the power cable (part number 26035455) to
the FROM GSIOC ACCESSORY port on the injection module.

3 Connectthe other end of the power cable to one of the GSIOC ACCESSORIES
ports on the rear panel of the liquid handler.

Unit ID

The unit ID on the GX Direct Injection Module is set to 3. The unit IDs are:
Left GX Direct Injection Module - unit ID=3
« Right GX Direct Injection Module - unit ID=4
Note: If only one GX Direct Injection Module is being used it can be placed on

either the left or the right but the unit ID must correspond to its location on the
locator plate.

To change the unit ID: GX Direct

Injection

FROM GSIOC —
ACCESSORY
port

1 Gently insert a small
flat-blade screwdriverinto
the selector on the rear
panel and turn it.

2 Align the white dot with :
one of the indicated '
numbers. 1 GX-281 (partial)

Gilson GX-281 Liquid Handler User’s Guide
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Rack Installation

Installation

2-24

Rack Installation

The GX-281 Liquid Handler is equipped to locate up to six Code 200-series racks.
Racks information can be found at www.gilson.com.

To install a rack:

1 Orient the rack so that the code number (for example, 200) is facing forward.

2 Fitthe rack on the locator plate so that the slots and holes on the underside
of the rack align with the pins on the locator plate.

Gilson GX-281 Liquid Handler User’s Guide
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Installation

RS-232, GSIOC, and Input/Output Connections

RS-232 Port

The RS-232 port is used to transfer information between the liquid handlerand a

computer. To connect your computer to the liquid handler, you will need the
RS-232 cable (part number 36083122, included in the accessory package).

To connect the RS-232 cable

1 Connect the male end of the RS-232 cable to the RS-232 port located on the

rear panel of the liquid handler. Tighten the retaining screws.

2 Connect the female end of the RS-232 cable to the computer’s RS-232 serial
communications port. Tighten the retaining screws.

RS-232

e®

@@

ee®

liquid handler

CI0H]

to computer

RS-232 cable

Gilson GX-281 Liquid Handler User’s Guide
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RS-232, GSIOC, and Input/Output Connections

Installation

n n

to computer

GSIOC

2-26

GSIOC Port

Use the GSIOC cable (part number 36078143, included in the accessory package)
to link other instruments to the liquid handler and control all from one computer.

To connect the GSIOC cable:

30"

il 10
Ul L)

1 Connect the female connector, located individually at one end of the cable,
to the GSIOC port of the liquid handler. Tighten the retaining screws.

2 Connect the other female connector, located on the same end as the male
connector, to the Gilson module. Tighten the retaining screws.

If you are connecting more than one Gilson module, use the male connector to
attach an additional GSIOC cable. Use the female connectors to connect to each

Gilson module.

Cables should be arranged in a linear fashion. Any “Y-branching from the main

GSIOC cable may create noise.

\/—?55-232 cable

w
| —
liquid handler Gil
ilson
RS-232
R s ® @ @ ® module
G @ 0 ® © “
n—n “;;
Gilson
GSIOC cable 5| module
y LE I

GSIOC Expansion Port

The GSIOC expansion port is not used.
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Installation

Input/Output Ports

You can use the inputand output contacts on the rear panel of the liquid handler
to control peripheral devices. Refer to Rear Panel Connections on page 2-17 for
the location of the input/output ports.

Inputs

The input terminal block of the liquid handler has ten contacts. All of the inputs

are paired, and each pair include a GROUND reference (¥ ).

The contact input pairs are labeled A, B, C, and D; there is also a safety contact
input.

A contact is connected if it has a short across the input or is held low by a TTL
output or other device.

Never connect voltages higher than 5V DC to an input. When using TTL signals,
be sure to match GROUND connections.

Outputs

The output terminal block has ten contacts.

Pins 1 through 8 are paired, isolated-relay contact closures and are labeled 1, 2, 3,
and 4.

Pins 9 and 10 are ANALOG IN and require an analog signal (+/- 1V).

DC Power Outputs

The four DC power outputs can be turned on (supplying +24V DC) or off (+24V
DC output will float) via software control.

Gilson GX-281 Liquid Handler User’s Guide
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RS-232, GSIOC, and Input/Output Connections

Installation

terminal block
connector

RN NN==NN

2-conductor
cable

|

to peripheral
equipment

2-28

Make Connections

To make connections, you'll need the following:

2-conductor cable (22-30 gauge for each wire)

You can purchase a 6-foot piece of suitable cable (part number 709910206)
or a package of 5 cables with identification markers (part number 36078155)
from Gilson.

wire insulation stripper

small-blade screwdriver

To make connections with the 2-conductor cable:

Cut the cable into pieces of appropriate length.
Strip about 3 mm of insulation from each end of the cable.

Remove the terminal block connector from the liquid handler. Insert each
wire into the appropriate terminal on the terminal block connector.

Note: When making connections, be sure to maintain the correct orientation
of the connector relative to the port.

Push the wire all the way in; then tighten its corresponding pin screw.

Reconnect the terminal block connector to the liquid handler. Push the
connector in as far as it will go. It is designed to fit snugly into its receptacle.

Connect the opposite ends of the wires to the other device(s). Be sure to
match ground connections.

Label each cable to identify the purpose of the connection.

Gilson GX-281 Liquid Handler User’s Guide



Installation 2

Plumbing Connections
The tables and diagrams in the following sections provide detailed information
about making these plumbing connections:
«  For Drain Tubing see page 2-30
For GX Solvent System Plumbing see page 2-31

«  For Fraction Collection Valve Plumbing (Optional) see page 2-34

suoiauuo) buiquinid

For GX Z Injection Module Plumbing (Optional) see page 2-36
+ For Rinse Station Plumbing see page 2-38
For GX Rinse Pump Plumbing (Optional) see page 2-39
+ For GX Direct Injection Module Plumbing (Optional) see page 2-40
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Plumbing Connections

Installation
Drain Tubing
Locate the following items included in the GX-281 Accessory Package:
Part number Description
49081701 Barbed adapter, elbow, 1/8" NPT TO 3/8" tubing
49081702 Barbed adapter, straight, 1/8" NPT to 3/8" tubing
470343706 Tubing, 5/16" x 7/16", Tygon, two lengths of 10 feet each
Install the elbow fitting in the hole located on the right side of the locator plate
and install the straight fitting on the hole located at the back of the locator plate.
Attach one length of tubing to each fitting. Place the free ends of the tubing in
the waste container.
install straight fitting here
4— install elbow
o ° o ° ) ° o ° o ° o o° fltting here
[}
o
[¢]
o o o o jo ojo o o ojlo o o
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Installation

GX Solvent System Plumbing

This section will take you through the steps for plumbing the GX Solvent System.

Before making the connections, locate the items listed below.

Included with the solvent system:

Part number Description

49962142 Solvent valve to pump tubing, analytical (Analytical)
49948122 Solvent valve to pump tubing, prep (Prep)
499484021 Solvent inlet tubing

490032 Waste tubing, 0.063" ID x 0.125" OD, PTFE, clear (15 ft)
490410332 P-331 nut, 1/4-28 PEEK

49041027 P-359, 1/8" ferrule

Transfer Tubing

The transfer tubing is ordered separately, refer to the table below for

part numbers. If a GX Z Injection Module is being used, there is transfer tubing
included in the GX Z Injection Module Plumbing Package (part number
26035370).

Part number Description

49963972 Transfer tubing 500 pL (Analytical)
49962872 Transfer tubing 1.1 mL (Analytical)
499671112 Transfer tubing 5.5 mL (Analytical)
499424013 Transfer tubing 1.1 mL (Prep)
499471112 Transfer tubing 5.5 mL (Prep)
499474103 Transfer tubing 10.5 mL (Prep)
499483602 Transfer tubing 30 mL (Prep)
499486002 Transfer tubing 50 mL (Prep)

Note: The transfer tubing should already be routed through the Z-arm cable
assembly (see Z-Arm Cable Assembly Setup and Installation on page 2-9 for
details).
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Installation 2

®
©@®

Plumbing Connections

GX Solvent System and GX Solvent System, FC valve, and
FC valve plumbing GX Z Injection Module plumbing

a) transfer tubing assembly

« The end of the transfer tubing with the headless nut attached
and the shorter length of Z-arm cable should exit the same end
of the assembly.

+  The coiled end of the transfer tubing and the longer length of
Z-arm cable should exit the same end of the assembly.

b) PEEK tubing (for FC valve only)

c) Teflon waste tubing (for FC valve only)

d) PEEK tubing (for GX Z Injection Module only)
)

e) PEEK tubing (for GX Z Injection Module only)

The table and diagrams provide detailed information about making the
plumbing connections for the solvent system.
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° 2 2 before connecting to

port B on the solvent
system'’s pump.

‘.

- o906
=== XXl

Route the transfer tubing
through the clips on the
back of the liquid handler

to probe or GX Z Injection Module

A B

pump

to pump

Solvent inlet tubing to connect
to one solvent is included with
the solvent system. To connect
to more than one solvent, °pe ° °

additional solvent inlet tubing
(part number 499484021) can

be purchased. valve
GX Solvent
to waste System

solvent lines

Solvent System

Tubing

Connections

Port 1 to waste

Teflon tubing 0.063" ID x 0.125" OD x 15 feet
(part number 490032)

Upchurch P-331 PEEK nut and P-359 ferrule.

Ports 2-6 to reservoir

Solvent inlet tubing (part number 499484021)

40 inches of Teflon tubing (0.085" ID x 1/8" OD)

Connect the end of the tubing with the fitting attached to ports 2-6 on the
solvent selection valve. Place the other end in the appropriate solvent.

Center port to port A
(Analytical)

Solvent valve to pump tubing (part number 49962142)

14 inches of Teflon tubing (0.030" ID x 1/16" OD)

Connect the end with the headless nut to the center port on the valve and the
end with the fingertight fitting to port A on the pump.

Center port to port A
(Prep)

Solvent valve to pump tubing (part number 49948122)

14 inches of Teflon tubing (0.085" ID x 1/8" OD)

Connect one end to the center port on the valve and the other end to port A on
the pump.

Port B to probe 500 pL transfer tubing (part number 49963972)
(Analytical) 96 inches of Teflon FEP tubing (0.020" ID x 1/16" OD) | Connect the end with the headless nut to the probe and the end with the
fingertight fitting to port B on the pump.
1.1 mL transfer tubing (part number 49962872)
95 inches of Teflon FEP tubing (0.030" ID x 1/16" OD) | Connect the end with the headless nut to the probe and the end with the
fingertight fitting to port B on the pump.
5.5 mL transfer tubing (part number 499671112)
111 inches of Teflon FEP tubing (0.062" ID x 1/8" OD) | Connect the end with the headless nut to the probe and the other end to port B
on the pump.
Port B to probe 1.1 mL transfer tubing (part number 499424013)
(Prep)

87 inches of Teflon tubing (0.030" ID x 1/16" OD)

Connect one end to the probe and the other end to port B on the pump.

5.5 mL transfer tubing (part number 499471112)

102 inches of Teflon tubing (0.062" ID x 1/8" OD)

Connect the end with the headless nut to the probe and the other end to port B
on the pump.

10.5 mL transfer tubing (part number 499474103)

204 inches of Teflon tubing (0.062" ID x 1/8" OD) |

Connect one end to the probe and the other end to port B on the pump.

30 mL transfer tubing (part number 499483602)

360 inches of Teflon tubing (0.085" ID x 1/8" OD) |

Connect one end to the probe and the other end to port B on the pump.

50 mL transfer tubing (part number 499486002)

600 inches of Teflon tubing (0.085" ID x 1/8" OD) |

Connect one end to the probe and the other end to port B on the pump.

Port B to port 1 on
GX Z Injection Module

Transfer tubing (part number 499474103)

204 inches of Teflon tubing (0.062" ID x 1/8" OD)

Connect one end to port B on the pump.

Attach the P-654 adapter (part number 490410654 included in the
GX Z Injection Module plumbing package) to port 1 on the GX Z Injection
Module. Then connect the other end of the transfer tubing to the adapter.
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Plumbing Connections

Installation

2-34

Fraction Collection Valve Plumbing (Optional)

This section will take you through the steps for plumbing the fraction collection
valve.

Before making the connections, locate the Plumbing Package for the Low Mount
FC Valve (part number 26037270) which contains the following:

Part number Description

49953029 Tubing, 0.030" x 20 ft, PEEK

25077422 Collection tube, 1/8" TFE

25077423 Collection tube, 1/16" TFE

49041012 Nut, 1/16" black, (P-201) (5)

49041011 Ferrule, 1/16" red, (P-200R) (5)

F1410050 PVDF coupling for 1/4"-28 fitting, package of 5
49041015 Ferrule, flangeless, 1/8", TEFZEL (P-300) (1)

49041016 Nut, 1/4-28 x 1/8 Delrin (P-304) (1)

490032 Waste tubing, 0.063" ID x 0.125" OD, PTFE, clear (15 ft)
26036143 Tube and wire routing strip, GX-28X Z-arm

26036123 Tube and wire routing strip (blue/grey, not used with GX-281)

Note: The PEEK tubing and waste tubing should already be routed through the
Z-arm cable assembly and the tube and wire routing strip (see Z-Arm Cable
Assembly Setup and Installation on page 2-9 for details).

Assembling the Collection Probes

Refer to the following procedures to assemble the collection probes. The
probe packages come with all of the necessary materials.
For the 1/8" OD Teflon probe (part number 25077422):
1 Cut a piece of the supplied 1/8" OD tubing to approximately 75 mm.
2 Insertthe supplied nut and ferrule onto the tubing.
«  Forthe 1/16" OD Teflon probe (part number 25077423):
1 Cut a piece of the supplied 1/16" OD tubing to approximately 70 mm.

2 Insert the supplied nut and ferrule onto the tubing.
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Installing the Collection Probes

1 Insert the end of the collection probe with the fitting attached into the
COLLECT port of the valve.

2 Forthe 1/8" tubing, press the tubing against the back of the port and
finger-tighten the screw.

Note: For the 1/16" tubing make sure that the tubing does not extend past

the ferrule.

3 While holding the valve and collection probe, insert the collection probe into
the guide hole until 3 mm of tubing is exposed below the guide foot.

4 The 1/8" tubing uses the larger guide hole and the 1/16" tubing uses the
smaller guide hole.

The following table and diagram provide detailed information about making
plumbing connections for the fraction collection valve.

COLLECT DIVERT

to guide foot

to waste

from detector

fraction collection valve connections

top view

3-way valve

Tubing

Connections

INLET

COMM (common) port
to coupler

PEEK tubing 0.030" x 1/16" x 20 feet
(part number 49953029)

On both ends of the tubing, use an Upchurch P-201 nut (1/16", 1/4-28) and P-200
ferrule (1/16").

Route one end of the tubing down through the tube and wire routing strip and
connect it to the IN port of the valve. Connect the other end to a coupler
(part number F1410050).

DIVERT position

NO (normally open)
port to waste

Teflon tubing 0.063" ID x 0.125" OD x 15 feet
(part number 490032)

Use an Upchurch P-304 nut (1/8", 1/4-28) and P-300 ferrule (1/8") on one end of
the tubing. Route that end of the tubing down through the tube and wire
routing strip and then connect it to the DIVERT port of the valve. Place the other
end of the tubing in the waste container.

COLLECT position

NC (normally closed)
port to probe

1/16" TFE probe (part number 25077423)
or
1/8" TFE probe (part number 25077422)

Note: Information about making these connections can be found in Installing
the Collection Probes on page 2-35.

Gilson GX-281 Liquid Handler User’s Guide

2-35

suoiauuo) buiquinid



Plumbing Connections

Installation 2
GX Z Injection Module Plumbing (Optional)
This section will take you through the steps for plumbing the GX Z Injection
Module.
Before making the connections, locate the GX Z Injection Module Plumbing
Package (ordered separately, part number 26035370) which contains the
following:
Part number Description
499474103 Transfer tubing assembly, 10.5 mL
49942142 Injection valve to probe tubing assembly
4903180411 MZN1PK 1/16" Valco nut (5)
4903180511 ZF1PK 1/16" Valco ferrule (5)
49953029 Tubing, 0.030" x 20 ft, PEEK (2)
49041031 P-706 PEEK ZDV Union, 0.050 Thru Hole (2)
36610101 Wrench, 5/16-1/4
490410654 Adptr, extra long 1/4-28 10-32, PEEK (P-654)
Note: The transfer tubing and the two lengths of PEEK tubing should already be
routed through the Z-arm cable assembly (see Z-Arm Cable Assembly Setup
and Installation on page 2-9 for details).
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Installation

The table and diagram provide detailed information about making the plumbing

connections for t

he GX Z Injection Module.

to probe

to GX Solvent System port B
sample loop

to pump

to column

GX Z Injection
Module

Tubing

Connections

Port 1 to GX Solvent

Transfer tubing (part number 499474103)

System (port B)

204 inches of Teflon tubing (0.062" ID x 1/8" OD)

Attach the P-654 adapter (part number 490410654) to port 1.

Connect one end of the transfer tubing to the adapter in port 1. Connect the
other end to port B on the solvent system pump.

Port 2 to probe

Tubing, injection valve to probe (part number 49942142)

14 inches of tubing (0.030" ID x 1/16" OD)

One end of the tubing has an Upchurch P-287 nut and P-250 ferrule. Connect this
end to the probe. The other end of the tubing has an MZN1PK 1/16" nut

(part number 4903180411) and a ZF1PK 1/16" ferrule (part number
4903180511). Connect this end to port 2 on the valve.

Port 3 to port 6

sample loop (ordered separately)

Port 4 to column

PEEK tubing 0.030" x 1/16" (part number 49953029)

On one end of the tubing use an MZN1PK 1/16" nut (part number 4903180411)
and aZF1PK 1/16" ferrule (part number 4903180511). Connect this end to port 4
on the valve. Connect the other end to a P-706 PEEK ZDV union (part number
49041031). Then connect another length of the PEEK tubing to the union.

Port 5 to pump

PEEK tubing 0.030" x 1/16" (part number 49953029)

On one end of the tubing use an MZN1PK 1/16" nut (part number 4903180411)
and a ZF1PK 1/16" ferrule (part number 4903180511). Connect this end to port 5
on the valve. Connect the other end to a P-706 PEEK ZDV union (part number
49041031). Then connect another length of the PEEK tubing to the union.
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Installation 2

Rinse Station Plumbing

To attach tubing to the drain:

1 Locate the Tygon drain tubing (part number

Plumbing Connections

470331206) included with the rinse station. =

2 Connectthedraintubingtothe barbed union onthe
rinse station.

3 If you are using a GX Rinse Pump, refer to the set up for
. . static rinse
instructions on page 2-39.

set up for
flowing rinse

drain/rinse station for
inside rinse of probe

rinse station for
outside rinse of probe
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Installation 2

GX Rinse Pump Plumbing (Optional)

Locate the following tubing included with the rinse pump:
+ 2.0 mm ID pharmed tubing assembly (part number 26035221)
« 1/16"ID x 3/16" OD neoprene tubing (part number 4715187060)

To install the tubing:

1 Remove the tubing clip from the top of the rinse pump by squeezing the
sides and then pulling it out.

tubing clip
~~ Squeeze here and

N pull to remove this
section

Slide these pieces out to
install the pharmed tubing

2 Remove the two pieces from the side of the pump head. Store the pieces for
future use. Place one end of the pharmed tubing assembly in the left side of
the pump head and snap into place.

3 Place the other end of the pharmed tubing assembly in the right side of the
pump head and snap into place.

4 Replace the tubing clip.

5 Connecta length of neoprene neoprene
neoprene tubing to thetop tubing to_%ﬁ %:tfubmg
i ] rom
barbed fitting on the right ;It::ieon reservoir

side and place the other
end in a reservoir.

6 Connectalength of neoprene tubing to the top barbed fitting on the left side
to the rinse station.

7 Repeat steps 5 and 6 for the bottom set of fittings.
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Plumbing Connections

Installation

GX Direct Injection Module Plumbing (Optional)

This section will take you through the steps for plumbing the GX Direct Injection

Module.

Before making the tubing connections, locate the Plumbing Package for the
GX Direct Injection Module (part number 26035470) which contains the

following:
Part number Description
4903180411 MZN1PK nut (5)
4903180511 ZF1PK ferrule (5)
495033 Teflon tubing, 0.020" ID x 1/16" OD, 10 ft/pk

The following table and diagram provide detailed information about making
plumbing connections for the GX Direct Injection Module.

| injection port

> to waste

>to pump

> to column

GX Direct Injection Module
for 1/16" OD Sample Loop

- injection port

e tO Waste

,to pump
,to column

GX Direct Injection Module
for 1/8" OD Sample Loop

GX Direct Injection
Module

Tubing

Connections

Port 1 to waste Teflon tubing, 0.020" ID x 1/16" OD

(part number 495033)

Use an MZN1PK 1/16" nut (part number 4903180411) and a ZF1PK 1/16" ferrule
(part number 4903180511) to connect the tubing to port 1 on the valve.

Port 2=injection port N/A

One of the following:

Injection port for 1.3 mm OD probe (part number 26035410)
Injection port for 1.3 mm OD probe, SS (part number 26035412)
Injection port for 1.5 mm OD probe (part number 26035411)
Injection port for 1.5 mm OD probe, SS (part number 26035413)

Port 3 to port 6 sample loop (ordered separately)

Port 4 to column

Use an MZN1PK 1/16" nut (part number 4903180411) and a ZF1PK 1/16" ferrule
(part number 4903180511) to connect the tubing to port 4 on the valve.

Port 5 to pump

Use an MZN1PK 1/16" nut (part number 4903180411) and a ZF1PK 1/16" ferrule
(part number 4903180511) to connect the tubing to port 5 on the valve.

2-40
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Final Rear Panel Connections

Fuses

You received the liquid handler without any fuses installed. To install the fuses:

1 Locate the accessory package containing the fuse drawer appropriate for
your line voltage.

2 Locatetheaccessory package containing the 5.0A “T" Slo-Blo fuse (5x20 mm
size) fuses.

3 Install the fuse(s) into the fuse drawer. The fuse drawer for 100-120V accepts
one fuse. The fuse drawer for 220-240V accepts two fuses.

4 Insert the fuse drawer into its receptacle in the liquid handler. Refer to Rear
Panel Connections on page 2-17 for the location of the fuse drawer.

Post | | Fuse
(- OoH
| | Fuse HH | | Fuse HH
fuse installation for 100-120 voltage fuse installation for 220-240 voltage

Power Cord Connection
Locate the appropriate power cord for your line voltage.

Use the power cord to connect the liquid handler to a power source.

Gilson GX-281 Liquid Handler User’s Guide
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Shield Installation

Installation

Shield Installation

To install the shield:

steel washer
screw

plastic washers \\/

RIGHT

plastic washers

ot e

screws 4 o

steel washers .
LEFT
SIDE

1 Locate the GX-281 Shield Kit (part number 26037751).

2 Mount the right side of the shield to the right support of the liquid handler
using the Phillips screws, steel washers, and plastic washers as shown in the
diagram.

3 Mounttheleft side of the shield to the left support of the liquid handler using
the Phillips screws, steel washers, and plastic washers as shown in the
diagram.
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Final Z-Arm Height Adjustment

Follow these steps to adjust the Z-arm to the proper height.

1

While holding on to the Z-arm, use the
supplied 5/32" T-handled Allen wrench to
loosen the mounting screw on the Z-arm
mounting bracket until the Z-arm can
slide up and down.

Slide Z-arm and adjust to proper height.
Refer to the scale on the side of the Z-arm
and set the clamp height to 125, 175, or
210.

The clamp height will be used in the
GX-281 Offset Utility described on
page 3-5 and in the controlling software.

Tighten the mounting screw on the Z-arm
mounting bracket so the Z-arm is secure.

Y-arm

Refer to Z-Arm Fine Adjust for a more precise adjustment.

Z-Arm Fine Adjust

1

Locate one of the Z-height adjustment tools

that was shipped with the liquid handler.
Refer to the table for part numbers.

Using the T-handled Allen wrench slightly
loosen the mounting screw.

Z-arm

mounting
screw

Part Number Height

25051094 125
25051095 175
95260007 210

ACAUTION | !f the Z-arm mounting screw is loosened too far, the Z-arm

could fall while performing the fine adjustment.

Place the Z-height adjustment tool under the Z-arm. Then place the Allen
wrench in the screw on the top left side of the Z-arm. Turn clockwise to lower

or counterclockwise to raise the Z-arm.

While holding the adjustment tool in place, slide the Z-arm off the Z-height
adjustment tool. Ensure that the bottom of the Z-arm lightly rubs against the
adjustment tool as it moves. Continue the fine adjustment until this is true.

Tighten the Z-arm mounting bracket so the Z-arm is secure.
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Unit ID Selection—GX-281 Liquid Handler

Installation 2

Unit ID Selection—GX-281 Liquid Handler

The unitID identifies each instrument to Gilson software packages that can issue

GSIOC commands to the instrument. There is no need to change this number

unless it is the same as that assigned to another Gilson instrument that’s also

connected along the GSIOC.

The unit ID on the GX-281 Liquid Handler is set using the front panel of the

instrument. At the factory, Gilson set the unit ID to 25.

To change the unit ID:

1 Make sure the liquid handler is connected to a power source.

2 Turnon the liquid handler using the power switch located on the rear panel.
Do NOT press the ON/OFF button on the front panel.

3 Press and hold the STOP button.

4 While still holding the STOP button, press and hold the ON/OFF button until
the indicator light turns green.

5 Release the ON/OFF button. DO NOT release the STOP button.

6 The unit ID appears on the display. The unit ID will change while you are
holding down the STOP button.

7  When the unit ID reaches the desired number release the STOP button.

Note: If you only want to confirm the unit ID, release the STOP button as soon as

the unit ID appears on the display.
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GX-281 Offset Utility

Run the GX-281 Offset Utility before operating the GX-281 under routine
software control.

Refer to GX-281 Offset Utility on page 3-5 for more information.

Gilson GX-281 Liquid Handler User’s Guide

2-45

31N 19sy0 L8Z-XD



Operation

Both TRILUTION® LC Software and TRILUTION® LH Software provide programmed control of the GX-281
Liquid Handler.
This chapter provides the following information:
A description of the Front Panel of the liquid handler
«  How to Start Up the liquid handler
An overview of the GX-281 Utility Programs
«  How to use the GX-281 Offset Utility

Aspirate and Dispense Sequences

Gilson GX-281 Liquid Handler User’s Guide
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Front Panel

Operation

3-2

Front Panel

The front panel of the liquid handler contains an ON/OFF button, a STOP button,
a two-line display, and a power indicator light.

power
indicator

ON/OFF Button

The ON/OFF button is active when the rear panel power switch is ON.

STOP Button

The STOP button can be used to stop the liquid handler from responding to any
more commands coming from the running program. This button also relaxes the
motors for the XYZ-arm so that you can easily lift the probe and move the arm.

In a situation where an emergency stop is required, pressing the STOP button
immediately stops the liquid handler.

Display

The two-line display shows the current status of the liquid handler and any error
codes as they are encountered. Your program can also contain instructions for
showing messages of up to two lines of 40 characters each on the display when
the program is run. Refer to Chapter 5, Troubleshooting for a list of current error
codes and required actions.

Power Indicator Light
The indicator becomes lit when you turn on power to the liquid handler using the

power switch located on the rear panel. When the ON/OFF button is pressed, the
indicator light turns green.
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Operation
Start Up
To start the liquid handler:
1 Make sure the liquid handler is connected to a power source.
2 Turn on the liquid handler using the power switch located on the rear panel.
Refer to Rear Panel Connections on page 2-17 for the location of this switch.
The power indicator light on the front panel illuminates.
After the power is turned on, press the ON/OFF button. The liquid handler
beeps and displays the current version of its installed firmware.
33
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GX-281 Utility Programs

Operation

GX-281 Utility Programs

The GX-281 Utility Programs CD (part number 21067527) contains the following
utility programs:

«  GX-281 Offset Utility—refer to GX-281 Offset Utility on page 3-5

GSIOC Configuration Editor—refer to Appendix D, GSIOC Configuration
Editor

«  GSIOC Utility—refer to Appendix E, GSIOC Utility

Install GX-281 Utility Programs
1 Insert the CD into the CD-ROM drive.

2 If the file does not start automatically, browse for SETUPEXE on the CD.

3 Follow the on-screen instructions to install the utility programs.
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Operation

GX-281 Offset Utility

It is recommended to run this utility at the time of installation and any time a
change is made to the Z-arm, such as installing a different probe, installing a
different guide foot assembly, or changing the clamp height.

The GX-281 Offset Utility is supplied on the GX-281 Utility Programs CD located
in the GX-281 Offset Utility Kit (part number 264976).

The following components are included in the kit:

«  GX-281 Utility Programs CD

«  GX-281 offset tool

«  8-32x5/8 steel socket head set screw

«  GX-281 Offset Utility Kit Instructions

Before You Begin

1 Ensure that plumbing and electrical connections have been made as
described in Chapter 2, Installation.

2 Ensure that the GX-281 Utility Programs have been installed. Refer to Install
GX-281 Utility Programs on page 3-4 for instructions.

3 Remove all racks from the locator plate.

4 Place the offset tool on an empty rinse station location or remove a rinse
station and put the offset tool in its place.

Start the GX-281 Offset Utility

Click Start > All Programs > Gilson Applications > GX-281 Liquid Handler >
GX-281 Offset Utility.

The GX-281 Offset Utility window will appear.

Gilson GX-281 Liquid Handler User’s Guide
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Operation

Set the Clamp Height

Select the Clamp Height and then click Set Clamp Height.

GX-281 Offset Utility

Set XY Offset

1 Select the Rinse Site where the offset tool is located and then
click Move To.

2 The arm will move to that location with the Z at the top and
relaxed.

3 Manually move the Z-arm down and align the probe to the
center of the offset tool using the arrow keys.

4 When the probe is centered, click Set to save the XY offset.

Set Z Offset
1 Select the Offset Z tab.
2 Click Move To.

3 Use the arrows to align the tip of the probe with the top of the
offset tool.

4 When the probe is aligned, click Set to save the Z offset.

Close Utility and Remove Tool

Close the software and then remove and store the offset tool.
Replace the rinse station if necessary.
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Operation

Aspirate and Dispense Sequences

Aspirating Fluid from a Well

Aspirate sequence: to waste

1 The selection valve on the solvent
system switches to waste
(position 1)

2 The solvent system starts moving,
aspirating fluid from the well. The
fluid in the transfer tubing is
dispensed to waste.

Dispensing Fluid to a Well

Dispense sequence:

1 The selection valve switches to
reservoir (positions 2-6).

from - | &

2 The solvent system starts moving, reservoir

dispensing fluid to the well. The
fluid is aspirated from reservoir.

Gilson GX-281 Liquid Handler User’s Guide
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Maintenance 4

To obtain optimum performance and maximum life from the GX-281 Liquid Handler, it is important to
keep the instrument well-maintained.

The GX-281 Liquid Handler is intended to be used in a laboratory environment by trained technical
personnel.
This chapter contains the following information to help you maintain your liquid handler.
Helpful Hints
+ Cleaning
Replacing Parts

« Transporting the Liquid Handler
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Helpful Hints

Maintenance

4-2

Helpful Hints

To keep your liquid handler at peak performance, it is recommended that you do
the following:

« Change or clean the tubing regularly to maintain maximum performance.

Flush the probe and rinse stations daily with distilled or deionized water. On
a weekly basis, flush these instruments with a 10% solution of bleach or weak

detergent.
+  Check periodically to ensure that all fittings are tight.
+  Wipe up all spills immediately.

«  Warm fluids to room temperature before running them through the system;
cold fluids may cause leakage.
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Cleaning

Cleaning the Liquid Handler

The liquid handler should be cleaned occasionally using a dry, clean cloth. Or, if
necessary, use a cloth dipped in soapy water. If liquid is accidentally spilled on the
liquid handler, wipe the instrument using a dry, clean cloth.

Cleaning the Fluid Path

Depending upon your use of the liquid handler, it may be necessary to flush the
entire fluid path.

It's important to clean the fluid path if you won't be using the liquid handler for
a while or if you're using a solution with a high salt concentration for a probe
wash or as a diluent. Refer to the following instructions.

/NCAUTION | To prevent injury, observe good laboratory practices when

handling solvents. Know the physical and chemical properties.
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path with 30% ethanol. The fluid path has now been cleaned
appropriately for weekend storage (or longer).

3 Prime and flush the fluid path with distilled or deionized water before
running applications.

Cleaning Methods

Depending on the samples or reagents that come into contact with the fluid
path, you may need to vary your cleaning methods accordingly. Use the
following cleaning protocols as references and make any changes to them as
required for the samples and reagents being pumped for your application.

Gilson GX-281 Liquid Handler User’s Guide 4-3
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Proteins and peptides

Follow this procedure if the fluid path is in contact with proteins and peptides.

/ACAUTION | To preventinjury, observe good laboratory practices when
handling solvents. Know the physical and chemical properties.
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path using a weak detergent solution.

3 Pause the priming sequence.

4  After 30 minutes, resume flushing and priming the fluid path using distilled
or deionized water to pump the remaining detergent from the tubinginto a
waste container.

5 When you're satisfied that the entire fluid path has been flushed with water,
end the priming sequence.

Acidic compounds, basic compounds, or salt solutions

Follow this procedure if the fluid path is in contact with acidic compounds, basic

compounds, or salt solutions.

/NCAUTION | To prevent injury, observe good laboratory practices when
handling solvents. Know the physical and chemical properties.
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path using a 0.1N NaOH solution.

3 Pause the priming sequence.

4  After 10 minutes, resume priming the fluid path using distilled or deionized
water. Prime until the fluid path has been flushed with water.

5 Pause the priming sequence.

6 Prime the fluid path using a 0.1N HCl solution.

7 Pause the priming sequence.

8 After 10 minutes, resume priming the fluid path using distilled or deionized
water.
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Biological fluids

Follow this procedure if the fluid path is in contact with biological fluids such as
blood products.

/NCAUTION | To prevent injury, observe good laboratory practices when

handling solvents. Know the physical and chemical properties.
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Make a solution of 10% bleach by adding one part of commercial bleach to
nine parts of water.

3 Flush the fluid path using the bleach solution.
4 Pause the priming sequence.

5 After 30 minutes, resume priming the fluid path using distilled or deionized
water to pump the remaining bleach solution from the tubing into a waste
container.

Gilson GX-281 Liquid Handler User’s Guide
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Replacing Parts

Replacing Tubing

Itis important to keep all tubing clean and free of crimps. Tubing that has

become dirty, blocked, or crimped can result in poor accuracy and precision, or

loss of air gap.

Replace both the transfer tubing and inlet tubing as needed. See Appendix A,

Replacement Parts and Accessories for part numbers for replacement tubing.

For tubing installation procedures, see Chapter 2, Installation.

Replacing the Probe

To install a replacement probe:

1 Remove the transfer tubing’s fitting connected to the top of the isolation
probe holder.

2 Graspthecurrent probe and push it up through the top of the isolation probe
holder.

3 Replace the lower probe holder. (Skip this step if the outer diameter of the
replacement probe is the same as the probe that was originally installed.)

a) Remove the lower probe holderby .

. isolation probe
placing the smaller end of the holder
1/4" socket over the bottom of the
lower probe holder. Rotate the
1/4" socket counterclockwise to  probe holder
loosen. Then remove the 1/4" sleeve
socket.

b) Separate the current lower probe cover
holder from the lower probe
holder cover. Place the lower probe I°W:r AL
holder cover over the new lower ~ P"92€ L

holder )
probe holder.

c) Place the smaller end of the 1/4" socket over the bottom of the lower
probe guide. Then place this assembly at the bottom of the probe holder
sleeve.

d) Rotate the 1/4" socket clockwise to tighten. Then remove the 1/4" socket.
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4 Replace the probe guide insert. (Skip this step if the outer diameter of the
replacement probe is the same as the probe that was originally installed.)

a)

b)

Remove the probe guide cover by loosening the two Phillips screws on
the bottom of the guide foot.

Remove the current probe guide insert and replace with the new probe
guide insert. Then re-install the probe guide cover.

5 Install the new probe by pushing it through the top of the isolation probe
holder. Make sure the tip of the probe sits inside the probe guide.

6 Replace and tighten the fitting.

7 Setthe Z travel height. (Skip this step if the length of the replacement probe
is the same as the probe that was originally installed.)

a)

b)

Push the isolation probe holder down as far as it will go.

Locate the 3/16" bolt that was included with the Z-arm. (If the Z travel
height was set for 125 mm or 175 mm probes, the bolt is installed in
either the S1 or S2 holes.

|: mm 3/16" bolt

Place the bolt on the supplied 3/32" Allen wrench and insert into the
proper hole on the Z-arm. Turn clockwise to tighten.

« S1for 125 mm probes
« S2for 175 mm probes

« No boltinstalled for 210 mm probes

Note: Store the bolt in the right side bracket hole on the back of the
liquid handler for future use.

8 Run the GX-281 Offset Utility. Refer to GX-281 Offset Utility on page 3-5 for
instructions.

Gilson GX-281 Liquid Handler User’s Guide
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Replacing a Fuse

A blown fuse may indicate the existence of another problem in the instrument. If

the replacement fuses blow, do not try additional fuses. Contact your

Gilson-authorized representative. See Before Calling Us on page 5-9.

To replace a fuse:

1 Disconnect the power cord from the power outlet and from the rear panel
receptacle.

2 Locate the fuse drawer on the rear panel. See Rear Panel Connections on
page 2-17 if necessary.

3 Inserta small screwdriver into the notch under the fuse drawer.

4 Using the screwdriver, lift up to remove the fuse drawer. The fuse drawer
contains one 5.0A “T” Slo-Blo fuse (5 x 20 mm size) for a 100-120 voltage
selection. It contains two 5.0A fuses for a 220-240 voltage selection.

5 Remove the old fuse(s) and insert the new fuse(s).

6 Insert the fuse drawer into its receptacle in the liquid handler.

7 Connect the power cord.
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Transporting the Liquid Handler

When moving the liquid handler to another location or when sending it back to

the factory, do not use the Y-arm as a handle. Always lift the liquid handler from
the base.

Gilson GX-281 Liquid Handler User’s Guide

19|pueH pinbi ayj bunuodsues)



Troubleshooting

This chapter provides information about the following topics:

+ Error Messages
« Mechanical and Electrical Troubleshooting

+ Repair and Return Policies

Gilson GX-281 Liquid Handler User’s Guide
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Error Messages

Troubleshooting

Error

Error Messages

Error Text

Solution

10

unknown buffered command

An unknown command was sent. Clear the error by sending
the buffered e command using the GSIOC Utility. Send a
known legal command. (Correct the error in the program
controlling the instrument.)

11

S buffer overflow

The S command buffer is full (up to 21 commands can be in
the buffer). Clear the error by sending the buffered

e command using the GSIOC Utility. Wait for some of the
commands to execute before sending another. (Correct the
error in the program controlling the instrument.)

12

safety contact closed

The safety contact was closed. Release contact; restart.

14

no pump configured

Attempt to use solvent system when not configured.
Check NVM location 5.

15

stop key pressed

The front panel “STOP” key was pressed. Clear the error by
sending the buffered e command using the GSIOC Utility.

16

invalid command parameter

A numerical parameter was out of range. Clear the error by
sending the buffered e command using the GSIOC Utility.
Then, enter a numerical parameter within the range.
(Correct the error in the program controlling the
instrument.)

17

invalid bar code angle

An invalid scan angle was specified. Enter a valid angle. The
angle can be from 5 to 36. (Correct the error in the program
controlling the instrument.)

18

S command while unhomed

A buffered S command was sent when the instrument was
not homed. Clear the error by sending the buffered

e command using the GSIOC Utility. Send a buffered

H command to home the instrument. Resend the buffered
S command. (Correct the error in the program controlling
the instrument.)

19

5-2

Direct Inject missing

Attempt to use a GX Direct Injection Module that is not
available. Check the unit ID of the GX Direct Injection
Module and make sure it is powered ON.
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Error Error Text Solution
Attempt to use a solvent system that is not available. Check
20 pump missing the unit ID of the solvent system and make sure it is powered

ON.

21

no Direct Inj configured

Attempt to use a GX Direct Injection Module with no speed
setting configured. Check NVM locations 11 and 12.

22

Z Inject missing

Attempt to use a GX Z Injection Module that is not available.
Check the connections to the GX Z Injection Module.

101

XY invalid command

An invalid XY command was received. Send a known legal
command. (Correct the error in the program controlling the
instrument.)

102

XY invalid NVM address

Attempt to write to an NVM address that doesn't exist.
(Correct the error in the program controlling the
instrument.)

103

X homing error

Home failed on the X-axis. Clear the error by sending the
buffered e command using the GSIOC Utility. Check for
obstructions. Check encoders.

104

Y homing error

Home failed on the Y-axis. Clear the error by sending the
buffered e command using the GSIOC Utility. Check for
obstructions. Check encoders.

105

XY target out of range

A command was sent to set the XY position outside of the

valid range. Resend the command with coordinates inside

the range. (Correct the error in the program controlling the
instrument.)

106

X stall or jam

XY motion measured by encoders does not match
requested motion. Check for a jammed arm, bad encoder.
Check cabling.

107

Y stall or jam

Motion measured by encoders does not match requested
motion. Check encoder cabling.

108

XY moved while unhomed

Gilson GX-281 Liquid Handler User’s Guide

Attempt to move to an XY location before completing the
homing sequence. Send the buffered H command. (Correct
the error in the program controlling the instrument.)
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Error Messages

Troubleshooting

Error

Error Text

Solution

109

XY move while busy

Attempt to move to an XY location while XY is still in motion.
Wait for the current commands to execute before sending
another. (Correct the error in the program controlling the
instrument.)

110

Park location invalid

Attempt to move to a configured park location that is out of
the allowed XY ranges. Check NVM locations 6 and 7.

201

Z invalid command

An invalid Z command was received. Send a known legal
command. (Correct the error in the program controlling the
instrument.)

202

Z invalid NVM address

Attempt to write to an NVM address that doesn't exist.
(Correct the error in the program controlling the
instrument.)

203

Z homing error

Home failed on the Z-axis. Clear the error by sending the
buffered e command using the GSIOC Utility. Check for
obstructions. Check encoders.

204

Z move while unhomed

Attempt to move to a Z location before completing the
homing sequence. Send the buffered H command. (Correct
the error in the program controlling the instrument.)

205

Z move while busy

Attempt to move to a Z location while Z is still in motion.
Wait for the current commands to execute before sending
another. (Correct the error in the program controlling the
instrument.)

206

Z stall or jam

Z motion measured by encoders does not match requested
motion. Check for free operation of axis, check encoder.

207

Z target out of range

A command was sent to set the Z position outside of the
valid range. Resend the command with coordinates inside
the range. (Correct the error in the program controlling the
instrument.)

208

Z speed invalid

The specified Z speed is outside of the valid range. (Correct
the error in the program controlling the instrument.)

209

5-4

invalid LED blink rate

The specified blink rate is outside the range. The valid range
is from 0 to 10. (Correct the error in the program controlling
the instrument.)
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Error

Error Text

Solution

210

unknown bar code reader

A command was sent to a bar code reader that does not
exist. (Correct the error in the program controlling the
instrument.)

211

primary bar code failed

Internal bar code reader not communicating when used.
Check Z-arm internal cabling.

212

invalid scan angle

The bar code reader received a command specifying an
angle that was outside the range. The valid range is from

5 to 36, or O for the default angle setting. (Correct the errorin
the program controlling the instrument.)

301

pump invalid command

An invalid solvent system command was received. Send a
known legal command. (Correct the error in the program
controlling the instrument.)

302

pump invalid NVM address

Attempt to write to an NVM address that doesn't exist.
(Correct the error in the program controlling the
instrument.)

303

solvent valve homing error

Home failed on the solvent selector valve. Replace the valve.

304

pump move while unhomed

Attempt to move the solvent selection valve before it is
homed. Send the buffered P command to home the solvent
system. (Correct the error in the program controlling the
instrument.)

305

pump move while busy

Attempt to pump or switch valve while pump or valve is still
moving. Wait for the current commands to execute before
sending another. (Correct the error in the program
controlling the instrument.)

306

solvent valve jam

Valve motion measured by encoders does not match
requested motion. Check encoder.

307

invalid aspirate volume

Aspirate volume is greater than tubing volume. Specify a
volume to aspirate that is less than the tubing volume.
(Correct the error in the program controlling the
instrument.)

308

dispense from waste

Gilson GX-281 Liquid Handler User’s Guide

The solvent system received a command to dispense from
the assigned waste port. (Correct the error in the program
controlling the instrument.)
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Troubleshooting 5

Error Error Text Solution

The solvent system received a command to aspirate to a
309 aspirate not to waste portother than the assigned waste port. (Correct the errorin
the program controlling the instrument.)

Error Messages

The specified flow rate is outside the range. The valid range
310 invalid flow rate is from 0.001 to 25 mL/min. (Correct the errorin the program
controlling the instrument.)

The solvent system received a command to turn the valve to
311 invalid solvent valve port an invalid position. (Correct the error in the program
controlling the instrument.)

The GX Direct Injection Module received an invalid
401 Dir Inj invalid command command. Send a known legal command. (Correct the error
in the program controlling the instrument.)

(Correct the error in the program controlling the

402 Dir Inj invalid NVM addr )
instrument.)

The GX Direct Injection Module received a command that
403 Dir Inj switch while busy instructed it to move while it was in motion. (Correct the
error in the program controlling the instrument.)

The GX Direct Injection Module received a command that
404 Dir Inj illegal position instructed it to go to aniillegal position. (Correct the error in
the program controlling the instrument.)
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Mechanical

Probe No Longer Finding Tube Center
«  Probe may be bent. Straighten or replace the probe.

+  Liquid handler may be misaligned. Follow the procedure in GX-281 Offset
Utility on page 3-5.

Gilson GX-281 Liquid Handler User’s Guide
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Electrical

Troubleshooting

5-8

Electrical

Input Functions Not Operating

Make sure connections into terminal block connector are secure.
Make sure terminal block connector is secure in input/output port.
Check connections for proper pin assignments.

Be sure pins from external devices are assigned correctly.

Check polarity of input. Inputs should be a contact closure. If not, it must be
TTL level (logic 0 activates).

Confirm that source supplying input to liquid handler is working.

Output Functions Not Operating

Make sure connections into terminal block connector are secure.
Make sure terminal block connector is secure in the input/output port.
Check connections for proper pin assignments.

Output from liquid handler should be compatible with device to which it is
interfaced. Outputs are contact closures.

Unit Not Operational

Make sure power is turned on.
Check power cord connections.
Try different outlet.

Check fuses; replace if necessary.

Check all liquid handler connections and make sure that the unit is plugged
in.

Unit Blows Fuses

Contact your Gilson-authorized representative.
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Repair and Return Policies

Before Calling Us
Gilson-authorized representatives will be able to serve you more efficiently if you
have the following information:

« the serial number and model number of the instruments involved. Refer to
the table for the location of the serial number.

Item Serial Number Location

GX-281 Liquid Handler Inside the right support, near the top
Z-arm Back side, at the top

GX Solvent System Right side

GX Direct Injection Module Right side
GX Z Injection Module Bottom

GX Rinse Pump Right side

+ theinstallation procedure you used
list of concise symptoms

- list of operating procedures and conditions you were using when the
problem arose

+ list of other devices connected to the liquid handler and a description of
those connections

list of other electrical connections in the room

Warranty Repair

Units covered under warranty will be repaired and returned to you at no charge.

If you have any questions about applicability, please contact your local
distributor.

Gilson GX-281 Liquid Handler User’s Guide
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Repair and Return Policies

Troubleshooting 5

Non-Warranty Repair

For out-of-warranty repairs, contact your local distributor. A Customer Service
representative will discuss service options with you and can assist in making
arrangements to return the equipment, if necessary.

Rebuilt Exchange

For some units, rebuilt exchange components are available. Contact your local
distributor for details.

Return Procedure

Contact your local distributor’s Customer Service Department to obtain
authorization before returning any Gilson equipment. To return a piece of
equipment:

«  Carefully pack the unit to prevent damage in transit. Check with your
distributor regarding proper method of shipment. No responsibility is
assumed by Gilson or your distributor for damage caused by improperly
packaged instruments. Indicate the authorization on the carton and on the
packing slip.

«  Always insure for the replacement value of the unit.
+ Include a description of symptoms, your name, address, phone number, and

purchase order to cover repair costs, return and shipping charges, if your
institution requires it.

Unit End-of-Life

When a unit reaches the end of its useful life, refer to www.gilson.com
for directions and information about the end-of-life policy. This is in
accordance with the European Union Directive 2002/96/EC on Waste

- Electrical and Electronic Equipment (WEEE).
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Replacement Parts and Accessories A

Part Number Description

261030 GX-281 Liquid Handler with GX Prep Solvent System

261031 GX-281 Liquid Handler with GX Prep Solvent System and bar code reader
261032 GX-281 Liquid Handler with GX Analytical Solvent System

261033 GX-281 Liquid Handler with GX Analytical Solvent System and bar code reader
Probes (125 mm)

Part Number Description

Septum-piercing probe; side-entry, capacitive level-sensing, stainless steel,
2507234 strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID (tip dimensions: 12 x 1.3 mm
OD, entry hole center is 3.5 mm from tip).

Septum-piercing probe; side-entry, vented, capacitive level-sensing, stainless steel,
2507235 strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID
(tip dimensions: 12 x 1.3 mm OD, entry hole center is 3.5 mm from tip).

Septum-piercing, short pencil-point probe; vented at 14 mm, side-entry, vented at

2507236 72 mm, capacitive level sensing, stainless steel. Dimensions: 272 x 1.8 x 0.8 mm ID.

Note: This probe is not compatible with the GX-Direct Injection Module.

Septum-piercing, pencil-point probe; vented at 72 mm, side-entry, capacitive level

2507237
sensing, stainless steel. Dimensions: 273 x 1.8 x 0.8 mm ID.
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Appendix A

Probes (125 mm) (Continued)

Part Number Description

Septum-piercing probe; deflected tip, capacitive level-sensing, stainless steel,
2507244 strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID
(tip dimensions: 12 x 1.3 mm OD, bevel cut entry hole).

Septum-piercing probe; deflected tip, vented, capacitive level-sensing, stainless steel,
2507245 strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID
(tip dimensions: 12 x 1.3 mm OD, bevel cut entry hole).

Septum-piercing probe; deflected tip, capacitive level-sensing, stainless steel with
Teflon-coated liquid path, strain-relief design.

Dimensions: 274 x 1.8 x 0.8 mm ID (tip dimensions: 12 x 1.3 mm OD, bevel cut entry
hole).

2507242

Septum-piercing probe; deflected tip, vented, capacitive level-sensing, stainless steel
2507243 with Teflon-coated liquid path, strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID
(tip dimensions 12 x 1.3 mm OD, bevel cut entry hole).

Non septum-piercing probe; bevel tip, capacitive level-sensing, stainless steel.

27067361 Dimensions: 220.5x 1.5x 1.1 mm ID.

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel.

2507414
Dimensions: 220 x 1.3 x 0.8 mm ID (tip dimensions: 1.5 x 0.9 x 0.46 mm ID).

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel.
27067373 Dimensions: 221 x 1.5x 1.1 mm ID
(tip dimensions: 2 x 1.1 x 0.4 mm ID).

Non septum-piercing probe; constricted bevel tip, capacitive level-sensing, stainless
27067374 steel. Dimensions: 221 x 1.5 x 1.1 mm ID
(tip dimensions: 2 x 1.1 x 0.4 mm ID).

Micro septum-piercing probe; constricted 45° bevel tip, capacitive level-sensing,
2507252 stainless steel. Dimensions: 220 x 1.5 x 1.1 mm ID
(tip dimensions: 10 x 0.7 x 0.4 mm ID).

Beveled-tip probe, stainless steel, grooved septum-piercing;

2507256
20725 221x1.5x0.4 mm ID.
97067375 Non-septum-piercing probe: beveled-tip, Teflon-coated stainless steel. Dimensions:
221x1.5x 1.1 mmID.
251646 Inert gas probe assembly (for maintaining an inert atmosphere inside sealed vessel),

beveled tip, stainless steel, strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID.
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Probes (125 mm) (Continued)

Part Number Description
97067382 Bevel tip probe, stainless steel, grooved septum piercing; 221 x 2.0 x 0.8 mm ID
(tip dimensions: 2.1 x 1.5x 0.8 mm ID, 100 uL volume).
970673821 Bevel tip probe, coated stainless steel, grooved septum piercing;
221 x2.0x 0.8 mm ID (tip dimensions: 2.1 x 1.5 x 0.8 mm ID, 100 pL volume).
27067383 Probe, septum-piercing, 221 x 1.5 x 0.4 mm, bevel tip, grooved, 28.73 uL volume
970673831 Probe, septum-piercing, coated, 221 x 1.5 x 0.4 mm, bevel tip, grooved, 28.73 uL
volume
Probes (175 mm)
Part Number Description
9507214 Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel.
Dimensions: 269 x 1.8 x 1.4 mm ID (tip dimensions: 1.5 x 1.2 x 0.79 mm ID).
9507215 Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel.
Dimensions: 269 x 1.3 x 0.8 mm ID (tip dimensions: 1.5 x 0.9 x 0.46 mm ID).
9507216 Non septum-piercing probe, bevel tip, capacitive level sensing, stainless steel.
Dimensions: 269 x 1.5 x 1.1 mm ID (tip dimensions: 1.6 x 1.2 x 0.79 mm ID).
Micro septum-piercing probe; constricted 45° bevel tip, capacitive level sensing,
2507253 stainless steel. Dimensions: 269 x 1.5 x 1.1 mm ID (tip dimensions: 10 x 0.7 x 0.4 mm
ID).
5507254 Non septum-piercing probe; flat tip, capacitive level-sensing, stainless steel.
Dimensions: 269 x 1.8 x 1.4 mm ID.
9507255 Non septum-piercing probe, bevel tip, capacitive level sensing, stainless steel.
Dimensions: 269 x 1.5 x 0.4 mm ID.
9507555 Inert non septum-piercing probe; Teflon-covered stainless steel.
Dimensions: 269 x 2.7 x 0.8 mm ID (tip dimensions: 5 x 1.5 mm OD).
25075551 Non septum-piercing probe; straight tip. Dimensions: 256.6 x 2.7 x 0.8 mm ID.
95073645 Non septum-piercing probe; beveled tip, capacitive level-sensing, stainless steel.

Gilson GX-281 Liquid Handler User’s Guide
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Appendix A

Probes (210 mm)

Part Number Description

Septum-piercing probe; bevel tip, grooved, stainless steel.

26037001
Dimensions 301.3 x 2.0 x 0.8 mm ID (tip dimensions: 2.1 x 1.5 x 0.8 mm ID)

Septum-piercing probe; bevel tip, grooved, stainless steel inert probe with
260370011 non-metallic coating.
Dimensions 301.3 x 2.0 x 0.8 mm (tip dimensions: 2.1 x 1.5 x 0.8 mm ID).

Septum-piercing probe; bevel tip, grooved.

26037002 Dimensions 304 x 1.5 x 0.4 mm.

260370021 Septum-piercing probe; coated. Dimensions 301.3 x 1.5 x 0.4 mm.
26037003 Micro septum-piercing probe. Dimensions 304 x 1.5 x 0.4 mm.

26037004 Angled tip probe. Dimensions 304 x 1.5 x 0.4 mm.

26037005 Non septum-piercing, beveled-tip probe. Dimensions 304 x 1.5 x 1.1 mm.
26037006 Straight tip probe. Dimensions 304 x 2.4 x 1.8 mm.

26037007 Straight tip probe. Dimensions 304 x 1.8 x 1.4 mm.

Guide Foot Assemblies, Probe Guide Inserts, and Lower Probe Holders

Part Number Description

26036197 Guide foot assembly for 1.3 mm OD probes
26036198 Guide foot assembly for 1.5 mm OD probes
26036199 Guide foot assembly for 1.8 mm OD probes
26036200 Guide foot assembly for 2.3 mm OD probes
26036201 Guide foot assembly for 2.7 mm OD probes

2603614215 Probe guide insert, 3-way, for 1.3 mm outer diameter probes

2603614216 Probe guide insert, 3-way, for 1.5 mm outer diameter probes

2603614217 Probe guide insert, 3-way, for 1.8 mm outer diameter probes

2603614218 Probe guide insert, 3-way, for 2.3 mm outer diameter probes

2603614219 Probe guide insert, 3-way, for 2.7 mm outer diameter probes

2603614111 Lower probe holder for 1.3 mm outer diameter probes
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Guide Foot Assemblies, Probe Guide Inserts, and Lower Probe Holders (Continued)

Part Number Description

2603614112 Lower probe holder for 1.5 mm outer diameter probes

2603614113 Lower probe holder for 1.8 mm outer diameter probes

2603614114 Lower probe holder for 2.7 mm outer diameter probes

Transfer Tubing for GX Analytical Solvent System

Part Number Description

49963972 Transfer tubing 500 pL volume

49962872 Transfer tubing 1.1 mL volume

499671112 Transfer tubing 5.5 mL volume

Transfer Tubing for GX Prep Solvent System

Part Number Description

499424013 Transfer tubing 1.1 mL volume

499471112 Transfer tubing 5.5 mL volume

499474103 Transfer tubing 10.5 mL volume

499483602 Transfer tubing 30 mL volume

499486002 Transfer tubing 50 mL volume

GX Solvent System and Accessories

Part Number Description

261349 GX Analytical Solvent System

261350 GX Prep Solvent System

49962142 Solvent valve to pump tubing, analytical (Analytical)
49948122 Solvent valve to pump tubing, prep (Prep)
499484021 Solvent inlet tubing
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Appendix

GX Solvent System and Accessories (Continued)

Part Number Description

490032 Waste tubing, 0.063" ID x 0.125" OD, PTFE, per ft (1/16" x 1/8")

490410332 P-331 nut, 1/4-28 PEEK

49041027 P-359, 1/8" ferrule

Rinse Pump, Rinse Stations, and Accessories

Part Number Description

261352 GX Rinse Pump

26034552 Rinse station, GX 125 mm (Rinse station for outside rinse of probe)
26034551 Rinse station, GX 175 mm (Rinse station for outside rinse of probe)
26034553 Rinse station, GX 210 mm (Rinse station for outside rinse of probe)
26034554 Rinse station, GX 125 mm FC (Drain/rinse station for inside rinse of probe)
26034555 Rinse station, GX 175 mm FC (Drain/rinse station for inside rinse of probe)
26034556 Rinse station, GX 210 mm FC (Drain/rinse station for inside rinse of probe)

470331206 Tygon drain tubing, 3/16" ID x 5/16" OD, per foot

26035221 2.0 mm ID pharmed tubing assembly

47151870604  1/16"ID X 3/16" OD neoprene tubing, 4 ft/pkg

Low Mount Fraction Collection Package and Accessories

Part Number Description

2604705 GX-Series Low Mount Fraction Collection package

26046114 Valve, 3-way, 200 mL PEEK 2xM3 TW

26037270 Plumbing package for the FC Valve (GX-271/GX-281)

49953029 Tubing, 0.030" x 20 ft, PEEK

25077422 Collection Tube, 1/8" TFE

25077423 Collection Tube, 1/16" TFE

49041012 Upchurch P-201 nut, flangeless, 1/16", 1/4-28, DELRIN® (ACETAL), black
49041011 Upchurch P-200R ferrule, flangeless, 1/16", TEFZEL® (ETFE), red
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Low Mount Fraction Collection Package and Accessories (Continued)

Part Number Description

F1410050 PVDF coupling for 1/4"-28 fitting, package of 5

49041015 Upchurch P-300 ferrule, flangeless, 1/8", TEFZEL® (ETFE), yellow
49041016 Upchurch P-304 nut, flangeless, 1/8", 1/4-28, DELRIN® (ACETAL), cream
490032 Waste tubing, 0.063" ID x 0.125" OD, PTFE, per ft (1/16" x 1/8")
26036143 Tube & wire routing strip, Z drive

Sample Loops for GX Direct Injection Module—Prep (1/16") and GX Z Injection Module

Part Number Description

494400002 250 pL stainless steel sample loop (1/16" OD) for Valco valves

494400005 500 pL stainless steel sample loop (1/16" OD) for Valco valves

49440001 1 mL stainless steel sample loop (1/16" OD) for Valco valves
49440002 2 mL stainless steel sample loop (1/16" OD) for Valco valves
49440005 5 mL stainless steel sample loop (1/16" OD) for Valco valves

Sample Loops for GX Direct Injection Module—Analytical (1/16") Stainless Steel

Part Number Description

49440003 2 L stainless steel sample loop (1/16" OD) for Valco valves
49440004 5 pL stainless steel sample loop (1/16" OD) for Valco valves
49440006 10 pL stainless steel sample loop (1/16" OD) for Valco valves
49440007 20 L stainless steel sample loop (1/16" OD) for Valco valves
49440008 50 pL stainless steel sample loop (1/16" OD) for Valco valves
49440009 100 pL stainless steel sample loop (1/16" OD) for Valco valves

494400002 250 pL stainless steel sample loop (1/16" OD) for Valco valves

494400005 500 pL stainless steel sample loop (1/16" OD) for Valco valves

49440001 1 mL stainless steel sample loop (1/16" OD) for Valco valves
49440002 2 mL stainless steel sample loop (1/16" OD) for Valco valves
49440005 5 mL stainless steel sample loop (1/16" OD) for Valco valves
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Appendix

Sample Loops for GX Direct Injection Module—Analytical (1/16") PEEK

Part Number Description

49440011 2 pL PEEK sample loop (1/16" OD) for Valco valves
49440012 5 uL PEEK sample loop (1/16" OD) for Valco valves
49440013 10 pL PEEK sample loop (1/16" OD) for Valco valves
49440014 20 pL PEEK sample loop (1/16" OD) for Valco valves
49440015 50 pL PEEK sample loop (1/16" OD) for Valco valves
49440016 100 pL PEEK sample loop (1/16" OD) for Valco valves
49440017 250 pL PEEK sample loop (1/16" OD) for Valco valves
49440018 500 uL PEEK sample loop (1/16" OD) for Valco valves

Sample Loops for GX Direct Injection Module—Prep (1/8")

Part Number Description

494400051 5 mL stainless steel sample loop (1/8" OD) for Valco valves
49440010 10 mL stainless steel sample loop (1/8" OD) for Valco valves
49440020 20 mL stainless steel sample loop (1/8" OD) for Valco valves
49440025 25 mL stainless steel sample loop (1/8" OD) for Valco valves

GX Direct Injection Module Accessories

Part Number Description

261354 GX Direct Injection Module, 1/16" Prep

261355 GX Direct Injection Module, 1/8" Prep

261356 GX Direct Injection Module, 1/16" Analytical, Stainless Steel

261357 GX Direct Injection Module, 1/16" Analytical, PEEK

26035470 Plumbing package for the GX Direct Injection Module

490318041 Valco MZN1PK PEEK nut (0.062" long) for 1/16" OD tubing, package of 10

4903180411 Valco MZN1PK PEEK nut (0.062" long) for 1/16" OD tubing, 1 each

490318051 Valco ZF1PK PEEK ferrule (1/16"), package of 10

4903180511 Valco ZF1PK PEEK ferrule (1/16"), 1 each
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GX Direct Injection Module Accessories (Continued)

Part Number Description

495033 Teflon tubing, 0.023" ID x 0.062" (1/16") OD, package of 10 ft

26035410 Injection port assembly, GX Direct Injection Module, for 1.3 mm OD probes
26035411 Injection port assembly, GX Direct Injection Module, for 1.5 mm OD probes
26035412 Lrt\ieecltion port assembly, GX Direct Injection Module, for 1.3 mm OD probes, stainless
26035413 Lrt\ieecltion port assembly, GX Direct Injection Module, for 1.5 mm OD probes, stainless
250510153 Injection port seal for 1.3 mm OD probes

2954674 Injection port seal for 1.5 mm OD probes

26035457 GX-281 Direct Injection Module riser block assembly

GX Z Injection Module and Accessories

Part Number Description

261353 GX Z Injection Module

26035370 Plumbing package for the GX Z Injection Module

36610101 Wrench, 5/16-1/4

490318041 Valco MZN1PK PEEK nut (0.062" long) for 1/16" OD tubing, package of 10
4903180411 Valco MZN1PK PEEK nut (0.062" long) for 1/16" OD tubing, 1 each
490318051 Valco ZF1PK PEEK ferrule (1/16"), package of 10

4903180511 Valco ZF1PK PEEK ferrule (1/16"), 1 each

49942142 Injection valve to probe tubing assembly

49953029 Tubing, 0.030" x 20 ft, PEEK

49041031 P-706 PEEK ZDV Union, 0.050 Thru Hole

490410654 Adptr, extra long 1/4-28 10-32, PEEK (P-654)

499474103 Transfer tubing assembly, 10.5 mL
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Appendix A

Cables, Connectors, and Fuses

Part Number Description

36083121 Serial cable, IBM PS/2-type, 25 to 25 pin
36083122 Serial cable, IBM AT-type, 9-pin female to 25-pin male
36083123 Serial cable adapter, 9-pin female to 25-pin male

638308512 Terminal block connector, 8-pin

638310512 Terminal block connector, 10-pin

6730504007 Fuse, 5.0 AT-5.0 slo-blo

709910206 2-conductor interconnect wire, 6, for making contact connections
36078143 Shielded GSIOC cable, 30"
25064040 Liquid Level Detection (LLD) cable

Z-Height Adjustment Tools

Part Number Description

25051094 125 mm Z-height adjustment tool
25051095 175 mm Z-height adjustment tool
95260007 210 mm Z-height adjustment tool
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Specifications Methods B

This appendix contains information about the methods used to obtain the specifications listed in the
Technical Specifications section in Chapter 1, Introduction.
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Appendix B

System

GX-281 Liquid Handler
125 mm Z travel clamped at 125 mm

«  Beveled-tip probe (part number 27067382), stainless steel, septum piercing;
221 x2.0x 0.8 mm ID, tip dimension 2.1 x 1.5 x 0.8 mm ID.

«  Drain/Rinse Station for Inside Rinse of Probe (part number 26034554)

« Rinse Station for Outside Rinse of Probe (part number 26034552)

GX Prep Solvent System
Volumetric Accuracy Transfer Tubing:
Transfer Tubing (part number 499483602) 30 mL, 0.085" x 1/8" x 360"
Transfer Tubing (part number 499474103) 10.5 mL, 0.062" x 1/8" x 204"
Transfer Tubing (part number 499424013) 1.1 mL, 0.030" x 1/16" x 87"
Reproducibility Transfer Tubing
Transfer Tubing (part number 49942222) 3 mL, 0.030" x 1/16" x 261"

GX Z Injection Module
«  Continuous flow Valco valve for 1/16" OD sample loops
« 2 mL stainless steel sample loop (part number 49440002)

+  GXZInjection Module plumbing package (part number 26035370)

GX Direct Injection Module for 1/8" OD Sample Loops

Continuous flow Valco valve with a vertical direct connection for the
injection port for 1/8" OD sample loops

« 10 mL stainless steel sample loop (part number 49440010)

+  GX Direct Injection Module plumbing package (part number 26035470)
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Volumetric Accuracy Method

Aspirate Rate

1 mL/min to 25 mL/min

Dispense Rate

1 mL/min to 25 mL/min

Rinse Volume

Inside 250 pL; Outside 500 pL

Liquid Transfer Method

DI Water and 50% Methanol:50% Water
1 Move Arm to Top
Aspirate 10 uL or 50 uL air gap at T mL/min from probe

Move Arm to Sample Location

2
3
4 Aspirate sample volume (100 uL to 25 mL) at (1.0 mL/min to 25 mL/min)
5 Move Arm to Top

6 Move Arm to Target Location

7

Dispense sample volume (100 pL to 25 mL) + % of the air gap volume at
(1.0 mL/min to 25 mL/min)

8 Move Arm to Top

9 Move Arm to Drain/Rinse Station GX-281

10 Dispense the remaining air gap

11 Rinse probe: dispense 250 pL from reservoir at 10 mL/min
12 Move Arm to Rinse Station GX-281

13 Rinse probe: dispense 500 pL from reservoir at 10 mL/min
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Appendix

B-4

Volumetric Accuracy Calculation
Percent accuracy = (dispensed weight/target weight) * 100

Volumetric accuracy data was obtained gravimetrically. A volume of deionized
water was dispensed in a source tube and then transferred to a target tube.

All gravimetric data was obtained using a Sartorius AC 210P four-place balance.
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Injection Reproducibility
Method—GX Z Injection Module

HPLC Pump

322 Pump
+  H2Pump Head

Detector

UV/Vis Detector

+  Wavelength: 254 nm
«  Sensitivity: 0.01AU

«  Peak Width: 0 sec

Column

Phenomenex Luna 5u C18(2) 100A, 100 X 21.2mm, 5 micron

Mobile Phase/Rinse Solvent
Isocratic 65% Methanol:35% Water

« Rinse Solvent 75% Methanol:25% Water

Flow Rate

« 15mL/min

Rinse Volume
The inside of the probe was rinsed with 1000 pL from reservoir at 10 mL/min

«  The outside of the probe was rinsed with 2000 pL from reservoir at
10 mL/min
Injections

Partial Loop injection. 750 pL was injected into a 2 mL sample loop.

« Teninjections of 500ug/mL Methyl Paraben, Ethyl Paraben, Propyl Parabenin
70% Methanol:30% Water from two sample tubes.
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Injection Method

Partial Loop Z Injection

1

0 N o v b~ w N

10
11
12
13
14
15
16
17
18
19
20
21

Move Z to Top

Move to Drain/Rinse Station GX-281

Move Z to Z Option and Z Offset

Dispense the volume held by the transfer tubing at 10 mL/min.
Move Z to Top

Set the Z injection valve to Load

Wait 1.2 seconds for the valve to switch

Aspirate air gap 10 pL at T mL/min

Move to Sample Well

Move Z to Z Option and Z Offset

Aspirate injection volume at 4 mL/min

Move Z to Top

Aspirate pull volume at 4 mL/min

Wait Injection Equilibration Time

Synchronize

Set the Z injection valve to Inject

Move Arm to Drain/Rinse Station GX-281

Dispense the volume held by the transfer tubing at 10 mL/min.
Rinse probe: dispense 1000 uL from reservoir at 10 mL/min
Move Arm to Rinse Station GX-281

Rinse probe: dispense 2000 uL from reservoir at 10 mL/min

Injection Reproducibility Calculation

cv

= (Standard deviation for injection set/ Average area for injection set) * 100
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Injection Reproducibility Method—GX Direct
Injection Module for 1/8" OD Sample Loops

HPLC Pump
333 Pump

334 Pump
«  H3 Pump Head

Detector

UV/Vis Detector

«  Wavelength: 230 nm
Sensitivity: 0.01AU

«  Peak Width: 0 sec

Column
«  Phenomenex Luna 10u C18(2) 100A, 50 X 50.0 mm, 10 micron

Mobile Phase/Rinse Solvent
. Gradient Methanol:Water

« Rinse Solvent 50% Methanol:50% Water

Flow Rate

« 75mL/min

Rinse Volume
« Theinside of the probe was rinsed with 300 pL from reservoir at 4 mL/min

The outside of the probe was rinsed with 450 pL from reservoir at 10 mL/min
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Injections
Partial Loop injection. 5000 pL was injected into a 10 mL sample loop.

« Teninjections of 20 mg/mL Methyl Paraben, Ethyl Paraben, Propyl Paraben in
50% Methanol:50% Water from two sample tubes.

Injection Method

Partial Loop Direct Injection

1  Move Zto Top

Set the injection valve to Inject

Move to Drain/Rinse Station GX-281

Move Z to Z Option and Z Offset

Dispense the volume held by the transfer tubing at 10 mL/min.
Move Z to Top

Aspirate air gap 20 pL at 0.5 mL/min

0 N o v b~ w N

Move to Sample Well

Move Z to Z Option and Z Offset

10 Aspirate injection volume + Extra Volume at 20 mL/min
11 Move Z to Top

12 Move to Injection Well

13 Move Z to Z Option and Z Offset

14 Dispense Extra volume at 15 mL/min

15 Set the injection valve to Load

16 Wait 1.2 seconds for the valve to switch

17 Dispense Injection volume at 15 mL/min

18 Wait Injection Equilibration Time

19 Synchronize

20 Set the injection valve to Inject

21 Rinse probe: dispense 300 L from reservoir at 4 ml/min

22 Move Arm to Rinse Station GX-281
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23 Move Z to Z Option and Z Offset

24 Rinse probe: dispense 450 pL from reservoir at 10 mL/min

Injection Reproducibility Calculation

CV = (Standard deviation for injection set/ Average area for injection set) * 100
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Materials C

Materials*

Nitronic 60

Chemical resistance is similar to Type 316 stainless, but its resistance to galling and oxidation make it
superior to Type 316 or 303 in the majority of applications.

Stainless steel, Type 316

This is the standard tubing material for chromatography, suitable for a wide variety of applications. It is
cold drawn seamless, not welded, with close tolerances held on both ID and OD. Type 316 is most
commonly used for HPLC because of its superior chloride ion resistance.

PAEK

Polyaryletherketone is the generic name for the family of polyketone compounds. PAEK includes PEK,
PEEK, PEKK, and PEKEKK, which differ in physical properties and, to a lesser degree, in inertness.

A range of PAEK-based composites are used for valves and fittings. These composites resist all common
HPLC solvents and dilute acids and bases. However, concentrated or prolonged use of halogenated
solvents may cause the polymer to swell. Avoid concentrated sulfuric or nitric acids (over 10%).
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PEEK

Considered relatively inertand biocompatible, polyetheretherketone tubing can
withstand temperatures up to 100°C. Under the right circumstances,
0.005"-.020" ID tubing can be used up to 5000 psi for a limited time, and 0.030"
to 3000 psi. Larger IDs are typically good to 500 psi. These limits will be
substantially reduced at elevated temperatures and in contact with some
solvents or acids.

Its mechanical properties allow PEEK to be used instead of stainless in many
situations and in some environments where stainless would be too reactive.
However, PEEK can be somewhat absorptive of solvents and analytes, notably
methylene chloride, DMSO, THF, and high concentrations of sulfuric and nitric
acid. This tubing is highly prone to “kinking,” or sealing off, if held in a sharp bend
over time.

Valcon H

This composite, a carbon fiber reinforced, PTFE lubricated inert engineering
polymer, has long been the standard for typical HPLC applications in which
pressures are around 5000 psi and temperatures are not more than 75°C.

* Information provided by Valco Instruments Company Inc.
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GSIOC Configuration Editor D

The GSIOC Configuration Editor enables you to modify COM (serial communications) port and baud rate
information. Or, you can use this editor if incorrect information appears in the GSIOC Utility window.

1 Locate the GSIOC Configuration Editor (GSCONFIG.EXE) using Windows Explorer or the shortcut at
Start > Programs > Gilson Applications > Utilities > GSIOC Configuration Editor. During
installation, this editor was stored to C:\GILSON\UTIL unless the installation path was changed.

2 Start the editor. The GSIOC Configuration Editor window appears.

1l GSIOE Configuration Editor [5€]

Pret Settings - GEIOC Serves
Proat Il'm'. 1 =

Bawd:  [19200

cucs_|

3 Inthe Port box, indicate the computer’s serial communications port (COM) port to which the Gilson
interface instrument (such as the liquid handler or 506C System Interface) is connected.

4 Click 19200 or 9600 to select the baud. The baud is the rate of data transmission between the
computer and the Gilson instrument.

5 Click OK to save the changes. A message box appears indicating that the computer must be
restarted before any changes become effective.
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GSIOC Utility E

The GSIOC Utility allows you to issue commands to Gilson GSIOC instruments. Your Gilson-authorized
representative may ask you to use this utility to verify that an instrument is connected correctly to the
computer. For communication to occur, the Gilson instrument must be connected via an RS-232

connection to the computer or connected via a GSIOC connection to a Gilson interface instrument that
is connected to the computer.
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Start the GSIOC Utility

1 Locate the GSIOC Utility (GSUTIL32.EXE) using Windows Explorer or the
shortcut at Start > (All) Programs > Gilson Applications > Utilities >
GSIOC Utility. During installation, this utility was stored to C:\GILSON\UTIL
unless the installation path was changed.

2 Start the utility. The GSIOC Utility window appears.

1y by GERMC LIELiDy
Mode  Help

GRIOE Saever 103
Prat | LOM1 Ul 1D ) =
IRD (N
Baud | 19200

| bwrmdate | | Bullmed |

Command X
Aespnnae

Review the Port and Baud Information

In the GSIOC Utility window, review the COM port and baud information. If any
information is incorrect or missing, close the GSIOC Utility and use the GSIOC
Configuration Editor to update the information. Refer to Appendix D, GSIOC
Configuration Editor.

Listing GSIOC Instruments

Using the GSIOC Utility, you can determine the instruments currently connected
to the computer.

In the Mode menu, select Scan!

The Unit ID list box displays the unit IDs and the version of the connected
instruments. If any connected instruments are missing from the list, ensure that
the proper RS-232 or GSIOC connection exists between the computer and the
instruments, and that the instruments do not have duplicate unit ID numbers.

Gilson GX-281 Liquid Handler User’s Guide



Appendix

Basic Mode

In the Basic mode, immediate and buffered GSIOC commands can be sent to
specific Gilson instruments.

Review the Port, IRQ, and Baud information in this window. If any information is
incorrect or missing, close the GSIOC Utility and use the GSIOC Configuration
Editor to update the information.

There are two drop-down menus in the Basic mode of the Gilson GSIOC Utility:
“Mode Menu” and “Help Menu”.

Basic Mode Buttons and Features
Immediate Button

Sends an immediate command to the Unit ID selected.

Immediate commands request status information from an instrument. These
commands are executed immediately, temporarily interrupting any command in
progress.

You can find a list of valid immediate commands for each instrument in its
commands list or user’s guide.

Buffered Button

Sends a buffered command to the Unit ID selected.

Buffered commands send instructions to an instrument. These commands are
executed one at a time.

You can find a list of valid buffered commands for each instrument in its
commands list or user’s guide.

Command Field

Where the command to be sent is specified. For more information on sending
commands, see Send an Immediate Command on page E-16 or Send a
Buffered Command on page E-17.
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Response Field
Returns a response to an immediate or buffered command.
The response to a successfully completed buffered command is “ok”.

Refer to the user’s guide for the Gilson instrument for a description of the valid
response to immediate commands.

The response to an unsuccessfully completed immediate or buffered command
is “#error”.

Basic Mode Menus
Mode Menu

There are three options in the Mode menu: “Scan!”, “Advanced”, and “Ghost”.

Scan! Uriit 1D

. 233202
The Scan! option on the Mode menu allows you to 27 2152 5

scan for GSIOC instruments. After a scan, the Unit 1D 124333555‘%1

list box displays the unit IDs and the version of the 1333/1.10
connected instruments. If any connected

instruments are missing from the list, ensure that the proper RS-232 or GSIOC
connection exists between the computer and the instruments, and that the

instruments do not have duplicate Unit ID numbers.

Advanced P

The advanced option in the Mode menu allows you to switch
between the Basic and Advanced modes. A check mark it

means that the GSIOC Utility is in Advanced mode. =

Ghost

The Ghost option in the Mode menu makes the GSIOC Utility window
transparent (and always on top). This allows you to view another window behind
the Utility. The Utility will remain fully functional in the Ghost mode.
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Help Menu
Help Topics

When selected, the Help window for the Gilson GSIOC Utility appears.

A1nn >oIso

About

When selected, the About window appears.

This window displays the version of the Gilson GSIOC Utility, the GSIOC32.DLL,
and the GSIOC Server or Driver; and the Port, IRQ, and Baud set by the GSIOC
Configuration Editor.
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Advanced Mode
In the Advanced mode, immediate and buffered GSIOC commands can be sent
to specific Gilson instruments. In this mode, immediate and buffered commands
with comments can be saved to a command list to be used as needed. The
command lines can be repeated automatically to monitor the status of the
instrument.
Tt Gilson GSI0C Utility - Advanced
Ele Edic [fode Help

Unie (D |22 v Commend Cammand T e

Command P e .-

flesed
o )
Hm Repeat |1."n1l.', |‘I",'p-: Il:-:-u.lnnd Response I(.‘I:-n-:::': ~|
-.lf' £E I ¥ Z159E. 50 Teat
Qoo -0007
[ A I < 18 8 g Forrox
[EI Command List
Command Line
Review the Port, IRQ, and Baud information by selecting About... from the Help
menu. If any information is incorrect or missing, close the GSIOC Utility and use
the GSIOC Configuration Editor to update the information.
There are four drop-down menus in the Advanced mode of the Gilson GSIOC
Utility: “File Menu”, “Edit Menu”, “Mode Menu”, and “Help Menu”.
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Advanced Mode Buttons and Features

+ Button

The next to is used to insert an immediate command in the

command list. For more information, see Insert an Immediate Command on
page E-14.

The nextto | Buffered | is used to insert a buffered command in the

command list. For more information, see Insert a Buffered Command on
page E-15.

Arrow Up or Arrow Down Button

These buttons ( or ) are used to change the position of a command in
the command list.

To move a command

Highlight the command in the command list and use to move the
command up in the list or to move the command down in the list.

Immediate Button

Sends an immediate command to the Unit ID selected. The Comment field is not
used.

Selecting the Immediate button will not add the command to the command list.

For more information, see Send an Immediate Command on page E-16.
Buffered Button

Sends a buffered command to the Unit ID selected. The Comment field is not
used.

Selecting the Buffered button will not add the command to the command list.

For more information, see Send a Buffered Command on page E-17.
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Response Field

Returns a response to an immediate or buffered command.
The response will become gray after 15 seconds if no response is registered.
The response to a successfully completed buffered command is “ok”.

Refer to the user’s guide for the Gilson instrument for a description of the valid
response to the immediate commands.

The response to an unsuccessfully completed immediate or buffered command
is “#error”.

To send a command line

Double-click on the Unit, Type, Command, Response, or Comment field to send
the immediate or buffered command for that specific command line.
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Command Line Column Headings

Repeat

A green check mark (-#) in the Repeat column means that an immediate
command will automatically repeat when the Auto Repeat option is checked.
Double-click on the Repeat field to select or deselect the Auto Repeat for that
command line.

Avyellow check mark (+#") in the Repeat column means that a buffered command
will automatically repeat when the Auto Repeat option is checked. Double-click
on the Repeat field to select or deselect the Auto Repeat option for that
command line.

Unit

This is the Unit ID for the instrument in the command line.
Type

| - “lImmediate Command”, B - “Buffered Command”
Command

This is the GSIOC command for the command line.
Response

This is the GSIOC response when the command line is initiated with a
double-click on the Unit, Type, Command, Response, or Comment field. The
response will become gray after 15 seconds if no response is registered.

Comment

This is an optional comment that can be added to the command line.

Gilson GX-281 Liquid Handler User’s Guide

E-9

A1nn >oIso



GSIOC Utility

Appendix E
Advanced Mode Menus
File Menu
There are four options in the File menu: “Open”, “Save”, “Save As.., and “Exit".
Open
The Open option in the File menu allows you to open previously created
command lists (GSUTIL32 files). The extension for a GSUTIL32 file is .GSU.
Save
The save option in the File menu allows you to save the Advanced commands to
GSUTIL32.GSU. The GSUTIL32.GSU file is automatically created in the location
where GSUTIL32.EXE is stored.
The Advanced commands will automatically be saved to GSUTIL32.GSU if the
Gilson GSIOC Utility is exited without saving.
The GSUTIL32. GSU is automatically opened when the Advanced mode is
selected from the Mode menu.
Save As...
The Save As... option on the File menu allows you to save the Gilson GSIOC Utility
commands that are currently defined. The file's name and path must be specified.
Exit
Closes the Gilson GSIOC Utility software.
Edit Menu
There are four options in the Edit Menu: “Insert Immediate”, “Insert Buffered”,
“Selection”, and “Font....
Insert Immediate
The Insert Immediate option in the Edit menu allows you to insert an immediate
command in the command list. The new command will be added to the last line
in the command list.
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The GSIOC Command will not be inserted if there is already a command line in
the list with the same Unit ID and Command.

For more information, see Insert an Immediate Command on page E-14.

Insert Buffered

The Insert Buffered option in the Edit menu allows you to insert a buffered
command in the command list. The new command will be added to the last line
in the command list.

The GSIOC Command will not be inserted if there is already a command line in
the list with the same Unit ID and Command.

For more information, see Insert a Buffered Command on page E-15.
Selection

Delete (Ctrl + D)

Deletes the highlighted command from the command list.

Up (Ctrl + U)

Moves the highlighted command up in the command list.

Down (Ctrl + D)

Moves the highlighted command down in the command list.
Execute (Ctrl + E)

Executes the highlighted command.

Repeat (Ctrl + R)

Adds or removes the repeat option for the highlighted command.
Font...

The Font... option on the Edit menu allows you to change the font options for the
command list fields and headers, as well as the Unit ID, Comment,and Command
text boxes.
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Mode Menu

There are four options in the Mode menu: “Scan!”, “Advanced”, “Auto Repeat”,
and “Ghost”.

Scan! Urit 1D

. 29 311202
The Scan! option on the Mode menu allows you to 22 2152 50

scan for GSIOC instruments. After a scan, the Unit 1D 124323555‘%1

list box displays the unit IDs and the version of the 1333110
connected instruments. If any connected

instruments are missing from the list, ensure that the proper RS-232 or GSIOC
connection exists between the computer and the instruments, and that the

instruments do not have duplicate Unit ID numbers.

Advanced o

The advanced option in the Mode menu allows you to switch
between the Basic and Advanced modes. A check mark

means that the GSIOC Utility is in Advanced mode. o

Auto Repeat

The Auto Repeat option on the Mode menu allows you to repeat command lines
that appear in the command list.

A command line will only repeat if a check mark appears in the Repeat field. A
check mark can be added by double-clicking on the Repeat field and selecting
the Auto Repeat check box.

Starting from the top command line, this mode will refresh one repeating
command line every 1/10th of a second. For example, if there are ten command
lines with Repeat selected, each of these command lines will be initiated every
second.

Auto Repeat mode is useful for monitoring the instrument using immediate
commands and is designated in the Repeat field with a green check mark.

Auto Repeat mode is not intended to be used as a programming tool with
buffered commands. Repeating buffered commands will be executed at a fixed
time interval regardless if a command has finished. For this reason, the check
mark in the buffered command line is yellow.
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Auto Repeat mode can be selected from the Mode menu or by selecting the
check box next to Auto Repeat.

Auto Repeat is deselected by default with the Advanced mode is first opened.
When Gilson GSIOC Utility - Advanced is saved or closed, the status of Auto
Repeat is saved.

Ghost

The Ghost option in the Mode menu makes the GSIOC Utility window
transparent (and always on top). This allows you to view another window behind
the Utility. The Utility will remain fully functional in the Ghost mode.

Help Menu

Help Topics

When selected, the Help window for the Gilson GSIOC Utility appears.
About

When selected, the About window appears.

This window displays the version of the Gilson GSIOC Utility, the GSIOC32.DLL,
and the GSIOC Server or Driver; and the Port, IRQ, and Baud set by the GSIOC
Configuration Editor.
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Appendix E
Commands
Immediate Command
Immediate commands request status information from an instrument. These
commands are executed immediately, temporarily interrupting any command in
progress.
You can find a list of valid immediate commands for each instrument in its
commands list or user’s guide.
Buffered Command
Buffered commands send instructions to an instrument. These commands are
executed one at a time.
You can find a list of valid buffered commands for each instrument in its
commands list or user’s guide.
Insert an Immediate Command
There are two ways to insert an immediate command in Advanced mode.
Using the Edit Menu
1 Fromthe UnitID drop-down box, select the unit ID of the instrument to send

the command to.
2  Type a Command and Comment. (The comment is optional.)
3 Select Insert Immediate from the Edit menu. The new command will be
inserted at the bottom of the command list.

Note: The command will not be inserted if there is already a command line in the
list with the same Unit ID and command.
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Using the + Button

1 From the Unit ID drop-down box, select the unitID  Command Type
of the instrument to send the command to.

[ Immediate ] [ + ]

2 Type a Command and Comment. (The comment is

optional.) [ Buffered ] [ + ]

3 Click the button next to the Immediate
button. The new command will be inserted at the bottom of the command
list.

Note: The command will not be inserted if there is already a command line in the
list with the same Unit ID and command.

Insert a Buffered Command

There are two ways to insert a buffered command in Advanced mode.

Using the Edit Menu

1 From the Unit ID drop-down box, select the unit ID of the instrument to send
the command to.

2 Type a Command and Comment. (The comment is optional.)
3 Select Insert Immediate from the Edit menu. The new command will be

inserted at the bottom of the command list.

Note: The command will not be inserted if there is already a command line in the
list with the same Unit ID and command.
Using the + Button

1 Fromthe UnitID drop-down box, select the unit ID of the instrument to send
the command to.

2  Type a Command and Comment. (The comment is optional.)

3 Clickthe button next to the Buffered button. = Eommand Type

The new command will be inserted at the bottom of
the command list.

[ Immediate ] [ + ]

[ Buffered ] [ + ]

Note: The command will not be inserted if there is
already a command line in the list with the same Unit ID and command.
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Send an Immediate Command

Basic Mode

1 From the UnitID drop-down box, select the unit ID of the instrument to send
the command to.

2 Type (or select) a Command.

3 Click [nmedae .

Advanced Mode

Using the button

1 From the UnitID drop-down box, select the unit ID of the instrument to send
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click [nmedae .

Using Execute from the Edit menu
1 Highlight the command to be sent in the command list.

2 Choose Selection from the Edit menu and select Execute. (Or, type Ctrl + E.)

Using the command list

Double-click on the command line of the command you want to send.
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Send a Buffered Command

Basic Mode

1 From the Unit ID drop-down box, select the unit ID of the instrument to send
the command to.

2 Type (or select) a Command.

3 Click| Buffered |,

Advanced Mode

Using the button

1 From the Unit ID drop-down box, select the unit ID of the instrument to send
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click| Buffered |,

Using Execute from the Edit menu
1 Highlight the command to be sent in the command list.

2 Choose Selection from the Edit menu and select Execute. (Or, type Ctrl + E.)
Using the command list

Double-click on the command line of the command you want to send.

Gilson GX-281 Liquid Handler User’s Guide

A1nn >oIso



	Safety
	Voltage
	Probes
	Solvents
	Replacement Parts

	Introduction

	Description
	Optional Accessories

	Unpacking
	Standard Equipment
	Accessories
	Optional Accessories

	Customer Service
	Technical Specifications

	Installation

	Cable Clip Installation
	Z-Arm Setup
	Guide Foot Assembly
	Lower Probe Holder Installation
	Guide Foot Installation
	Fraction Collection Valve Installation (Optional)

	Z-Arm Cable Assembly Setup and Installation
	Z-Arm Cable Assembly Setup
	Z-Arm Cable Assembly Installation

	Z-Arm Installation
	Z-Arm Cable Connection
	Z Travel Height Adjustment
	Probe Installation
	LLD (Liquid Level Detection) Cable Installation

	GX Z Injection Module Installation (Optional)
	GX Z Injection Module Rear Panel

	Locator Plate Setup
	Rear Panel Connections
	GX Solvent System Installation
	Rinse Station Installation
	GX Rinse Pump Installation (Optional)
	GX Direct Injection Module Installation (Optional)

	Rack Installation
	RS-232, GSIOC, and Input/Output Connections
	RS-232 Port
	GSIOC Port
	GSIOC Expansion Port
	Input/Output Ports

	Plumbing Connections
	Drain Tubing
	GX Solvent System Plumbing
	Fraction Collection Valve Plumbing (Optional)
	GX Z Injection Module Plumbing (Optional)
	Rinse Station Plumbing
	GX Rinse Pump Plumbing (Optional)
	GX Direct Injection Module Plumbing (Optional)

	Final Rear Panel Connections
	Fuses
	Power Cord Connection

	Shield Installation
	Final Z-Arm Height Adjustment
	Z-Arm Fine Adjust

	Unit ID Selection—GX-281 Liquid Handler
	GX-281 Offset Utility

	Operation

	Front Panel
	ON/OFF Button
	STOP Button
	Display
	Power Indicator Light

	Start Up
	GX-281 Utility Programs
	Install GX-281 Utility Programs

	GX-281 Offset Utility
	Before You Begin
	Start the GX-281 Offset Utility
	Set the Clamp Height
	Set XY Offset
	Set Z Offset
	Close Utility and Remove Tool

	Aspirate and Dispense Sequences
	Aspirating Fluid from a Well
	Dispensing Fluid to a Well


	Maintenance

	Helpful Hints
	Cleaning
	Cleaning the Liquid Handler
	Cleaning the Fluid Path

	Replacing Parts
	Replacing Tubing
	Replacing the Probe
	Replacing a Fuse

	Transporting the Liquid Handler

	Troubleshooting

	Error Messages
	Mechanical
	Electrical
	Repair and Return Policies
	Before Calling Us
	Warranty Repair
	Non-Warranty Repair
	Rebuilt Exchange
	Return Procedure
	Unit End-of-Life


	Replacement Parts and Accessories

	Specifications Methods

	System
	Volumetric Accuracy Method
	Aspirate Rate
	Dispense Rate
	Rinse Volume
	Liquid Transfer Method
	Volumetric Accuracy Calculation

	Injection Reproducibility Method—GX Z Injection Module
	HPLC Pump
	Detector
	Column
	Mobile Phase/Rinse Solvent
	Flow Rate
	Rinse Volume
	Injections
	Injection Method
	Injection Reproducibility Calculation

	Injection Reproducibility Method—GX Direct Injection Module for 1/8" OD Sample Loops
	HPLC Pump
	Detector
	Column
	Mobile Phase/Rinse Solvent
	Flow Rate
	Rinse Volume
	Injections
	Injection Method
	Injection Reproducibility Calculation


	Materials

	Materials*
	Nitronic 60
	Stainless steel, Type 316
	PAEK
	PEEK
	Valcon H


	GSIOC Configuration Editor

	GSIOC Utility

	Start the GSIOC Utility
	Review the Port and Baud Information
	Listing GSIOC Instruments

	Basic Mode
	Basic Mode Buttons and Features
	Basic Mode Menus

	Advanced Mode
	Advanced Mode Buttons and Features
	Advanced Mode Menus

	Commands
	Immediate Command
	Buffered Command
	Insert an Immediate Command
	Insert a Buffered Command
	Send an Immediate Command
	Send a Buffered Command



